

    
      
          
            
  
Welcome to Read the Docs

This is an autogenerated index file.

Please create a /home/docs/checkouts/readthedocs.org/user_builds/ef/checkouts/latest/index.rst or /home/docs/checkouts/readthedocs.org/user_builds/ef/checkouts/latest/README.rst file with your own content.

If you want to use another markup, choose a different builder in your settings.
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Microsoft Open Source Code of Conduct

This project has adopted the Microsoft Open Source Code of Conduct [https://opensource.microsoft.com/codeofconduct/].
For more information see the Code of Conduct FAQ [https://opensource.microsoft.com/codeofconduct/faq/] or contact opencode@microsoft.com with any additional questions or comments.




Entity Framework Docs

This project provides the source for docs.microsoft.com/ef [http://docs.microsoft.com/ef/].

We accept pull requests! However, before submitting a pull request, please read the CONTRIBUTING guidelines, which include information on how to build the docs locally, as well as style and organizational guidance.





          

      

      

    

  

    
      
          
            
  
Contributing to the Entity Framework documentation

The document covers the process for contributing to the articles and code samples that are hosted on the Entity Framework documentation site [https://docs.microsoft.com/ef]. Contributions may be as simple as typo corrections or as complex as new articles.


How to make a simple correction or suggestion

Articles are stored in the repository as Markdown files. Simple changes to the content of a Markdown file can be made in the browser by tapping the Edit link in the upper right corner of the browser window. (In narrow browser windows you might need to expand the options bar to see the Edit link.) Follow the directions to create a pull request (PR). The EF team will review the PR and accept it or suggest changes.




How to make a more complex submission

You’ll need a basic understanding of Git and GitHub.com [https://guides.github.com/activities/hello-world/].


	Open an issue [https://github.com/aspnet/EntityFramework.Docs/issues/new] describing what you want to do, such as change an existing article or create a new one. Wait for approval from the EF team before you invest much time.

	Fork the aspnet/EntityFramework.Docs [https://github.com/aspnet/EntityFramework.Docs/] repo and create a branch for your changes.

	Submit a pull request (PR) to master with your changes.

	Respond to PR feedback.






Markdown syntax

Articles are written in DocFx-flavored Markdown [http://dotnet.github.io/docfx/spec/docfx_flavored_markdown.html], which is a superset of GitHub-flavored Markdown (GFM) [https://guides.github.com/features/mastering-markdown/]. For examples of DFM syntax for UI features commonly used in the EF documentation, see Metadata and Markdown Template [https://github.com/dotnet/docs/blob/master/styleguide/template.md] in the .NET Core repo style guide.




Folder structure conventions

Images, and other static content, are stored in an _static folder within each area/folder of the site.

Code samples are stored in the samples root folder. They are organized into a folder structure that mimics the documentation structure (found under the entity-framework root folder).




Code snippets

Articles frequently contain code snippets to illustrate points. DFM lets you copy code into the Markdown file or refer to a separate code file. We prefer to use separate code files whenever possible, to minimize the chance of errors in the code. The code files should be stored in the repo using the folder structure described above for sample projects.

Here are some examples of DFM code snippet syntax [http://dotnet.github.io/docfx/spec/docfx_flavored_markdown.html#code-snippet].

To render an entire code file as a snippet:

[!code-csharp[Main](../../../samples/core/saving/Program.cs)]





To render a portion of a file as a snippet by using line numbers:

[!code-csharp[Main](../../../samples/core/saving/Program.cs?range=1-10]





For C# snippets, you can reference a C# region [https://msdn.microsoft.com/en-us/library/9a1ybwek.aspx]. Whenever possible, use regions rather than line numbers, because line numbers in a code file tend to change and get out of sync with line number references in Markdown. C# regions can be nested, and if you reference the outer region, the inner #region and #endregion directives are not rendered in a snippet.

To render a C# region named “snippet_Example”:

[!code-csharp[Main](../../../samples/core/saving/Program.cs?name=snippet_Example)]





To highlight selected lines in a rendered snippet (usually renders as yellow background color):

[!code-csharp[Main](../../../samples/core/saving/Program.cs?name=snippet_Example&highlight=1-3,10,20-25)]








Test your changes with DocFX

Test your changes with the DocFX command line tool [https://dotnet.github.io/docfx/tutorial/docfx_getting_started.html#2-use-docfx-as-a-command-line-tool], which creates a locally hosted version of the site. DocFX doesn’t render style and site extensions created for docs.microsoft.com.

DocFX requires the .NET Framework on Windows, or Mono for Linux or macOS.


Windows instructions


	Download and unzip docfx.zip from DocFX releases [https://github.com/dotnet/docfx/releases].



	Add DocFX to your PATH.



	In a command line window, navigate to the cloned repository (which contains the docfx.json file) and run the following command:

docfx -t default --serve







	In a browser, navigate to http://localhost:8080.








Mono instructions


	Install Mono via Homebrew - brew install mono.



	Download the latest version of DocFX [https://github.com/dotnet/docfx/releases/tag/v2.7.2].



	Extract to \bin\docfx.



	Create an alias for docfx:

function docfx {
  mono $HOME/bin/docfx/docfx.exe
}

function docfx-serve {
  mono $HOME/bin/docfx/docfx.exe serve _site
}







	Run docfx in the cloned repository to build the site, and docfx-serve to view the site at http://localhost:8080.










Voice and tone

Our goal is to write documentation that is easily understandable by the widest possible audience. To that end we have established guidelines for writing style that we ask our contributors to follow. For more information, see Voice and tone guidelines [https://github.com/dotnet/docs/blob/master/styleguide/voice-tone.md] in the .NET Core repo.
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For product issues, use https://github.com/aspnet/EntityFramework/issues



          

      

      

    

  

    
      
          
            
  

layout: HubPage
title: Entity Framework
author: rowanmiller
ms.author: divega
ms.date: 10/27/2016
ms.assetid: 6bb12583-c39a-454c-8d83-d2a2793ca9ef
uid: index




    
        Entity Framework Documentation

        
            	
                Entity Framework
                
                    	
                        
                        
                            	
                                
                                    Entity Framework is an object-relational mapper (O/RM) that enables .NET developers to work with a database using .NET objects. It eliminates the need for most of the data-access code that developers usually need to write.

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    Entity Framework Core

                                                    EF Core is a lightweight, extensible, and cross-platform version of Entity Framework.

                                                

                                            

                                        

                                    

                                
                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    Entity Framework 6

                                                    EF 6 is a tried and tested data access technology with many years of features and stabilization.

                                                

                                            

                                        

                                    

                                
                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    Choosing

                                                    Find out which version of EF is right for you.

                                                

                                            

                                        

                                    

                                
                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    Port to EF Core

                                                    Guidance on porting and exiting EF 6 application to EF Core.

                                                

                                            

                                        

                                    

                                
                            

                        

                    

                

            

            	
                EF Core
                
                    	
                        all
                        
                            	
                                
                                    EF Core is a lightweight, extensible, and cross-platform version of Entity Framework.

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    [image: ]
                                                

                                            

                                            
                                                
                                                    Get Started
                                                

                                                
                                                    Overview
                                                

                                                
                                                    Create a Model
                                                

                                                
                                                    Query Data
                                                

                                                
                                                    Save Data
                                                

                                            

                                        

                                    

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    [image: ]
                                                

                                            

                                            
                                                
                                                    Tutorials
                                                

                                                
                                                    .NET Framework
                                                

                                                
                                                    .NET Core
                                                

                                                
                                                    ASP.NET Core
                                                

                                                
                                                    UWP
                                                

                                                
                                                    more…
                                                

                                            

                                        

                                    

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    [image: ]
                                                

                                            

                                            
                                                
                                                    Database providers
                                                

                                                
                                                    SQL Server
                                                

                                                
                                                    MySQL
                                                

                                                
                                                    PostgreSQL
                                                

                                                
                                                    SQLite
                                                

                                                
                                                    more…
                                                

                                            

                                        

                                    

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    [image: ]
                                                

                                            

                                            
                                                
                                                    ⤤ API Reference
                                                

                                                
                                                    DbContext
                                                

                                                
                                                    DbSet<TEntity>
                                                

                                                
                                                    more…
                                                

                                            

                                        

                                    

                                

                            

                        

                    

                

            

            	
                EF 6
                
                    	
                        
                        
                            	
                                
                                    EF 6 is a tried and tested data access technology with many years of features and stabilization.

                                

                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    ⤤ Get Started

                                                    Learn how to access data with Entity Framework 6.

                                                

                                            

                                        

                                    

                                
                            

                            	
                                
                                    
                                        
                                            
                                                
                                                    
                                                        [image: ]
                                                    

                                                

                                                
                                                    ⤤ API Reference

                                                    Browse the Entity Framework 6 API, organized by namespace.

                                                

                                            

                                        

                                    

                                
                            

                        

                    

                

            

        

    




          

      

      

    

  

    
      
          
            
  
Entity Framework


Compare EF Core & EF6


Which One Is Right for You




Feature Comparison




EF6 and EF Core in the Same Application




Porting from EF6 to EF Core


Validate Requirements




Porting an EDMX-Based Model




Porting a Code-Based Model








Entity Framework Core


New in EF Core 2.0


EF Core 1.0 (previous version)




EF Core 1.1 (previous version)






Getting Started


Installing EF Core




.NET Framework (Console, WinForms, WPF, etc.)


.NET Framework - New Database




.NET Framework - Existing Database






.NET Core (Windows, OSX, Linux, etc.)


.NET Core - New Database






ASP.NET Core


ASP.NET Core - New Database




ASP.NET Core - Existing Database




EF Core Tutorial on ASP.NET Core site [https://docs.asp.net/en/latest/data/ef-mvc/intro.html]






Universal Windows Platform (UWP)


UWP - New Database








Creating a Model


Including & Excluding Types




Including & Excluding Properties




Keys (primary)




Generated Values




Required/optional properties




Maximum Length




Concurrency Tokens




Shadow Properties




Relationships




Indexes




Alternate Keys




Inheritance




Backing Fields




Alternating models with same DbContext




Relational Database Modeling


Table Mapping




Column Mapping




Data Types




Primary Keys




Default Schema




Computed Columns




Sequences




Default Values




Indexes




Foreign Key Constraints




Alternate Keys (Unique Constraints)




Inheritance (Relational Database)








Querying Data


Basic Query




Loading Related Data




Client vs. Server Evaluation




Tracking vs. No-Tracking




Raw SQL Queries




Asynchronous Queries




How Query Works






Saving Data


Basic Save




Related Data




Cascade Delete




Concurrency Conflicts




Transactions




Asynchronous Saving




🔧 Disconnected Entities




Explicit values for generated properties






Supported .NET Implementations




Database Providers


Microsoft SQL Server


Memory-Optimized Tables






SQLite


SQLite Limitations






PostgreSQL (Npgsql)




IBM Data Server (DB2)




MySQL (Official)




MySQL (Pomelo)




Microsoft SQL Server Compact Edition




InMemory (for Testing)




Devart (MySQL, Oracle, PostgreSQL, SQLite, DB2, and more)




Oracle (not yet available)




MyCat




Writing a Database Provider






Managing Database Schemas


🔧 Migrations




🔧 Reverse Engineering






Command-Line Reference


Package Manager Console (Visual Studio)




.NET Core CLI




Design-time DbContext Creation




Design-time Services






Tools & Extensions


LLBLGen Pro




Devart Entity Developer




EFSecondLevelCache.Core




EntityFrameworkCore.Detached




EntityFrameworkCore.Triggers




EntityFrameworkCore.Rx




EntityFrameworkCore.PrimaryKey




EntityFrameworkCore.TypedOriginalValues




EFCore.Practices




LinqKit.Microsoft.EntityFrameworkCore




Microsoft.EntityFrameworkCore.AutoHistory




Microsoft.EntityFrameworkCore.DynamicLinq




Microsoft.EntityFrameworkCore.UnitOfWork






Miscellaneous


Connection Strings




Logging




Connection Resiliency




Testing


Testing with SQLite




Testing with InMemory






Configuring a DbContext




Upgrading from 1.0 RC1 to RC2




Upgrading from 1.0 RC2 to RTM




Upgrading to EF Core 2.0






⤤ API Reference [https://docs.microsoft.com/dotnet/api/?view=efcore-2.0]






Entity Framework 6


⤤ Documentation [http://msdn.com/data/ef]




⤤ API Reference [https://msdn.microsoft.com/library/dn223258.aspx]









          

      

      

    

  

    
      
          
            
  

title: Entity Framework 6
author: rowanmiller
ms.author: divega
ms.date: 10/27/2016
ms.assetid: d16eb5be-7e94-477a-84cd-e6dce25df12a
ms.technology: entity-framework-6
uid: ef6/index




Entity Framework 6

Entity Framework 6 (EF6) is a tried and tested data access technology with many years of features and stabilization. It first released in 2008, as part of .NET Framework 3.5 SP1 and Visual Studio 2008 SP1. Starting with the EF4.1 release it has shipped as the EntityFramework NuGet package [https://www.nuget.org/packages/EntityFramework/] - currently one of the most popular packages on NuGet.org.

The Entity Framework 6 documentation is currently available at msdn.com/data/ef [http://msdn.com/data/ef].
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Entity Framework Core Quick Overview

Entity Framework (EF) Core is a lightweight, extensible, and cross-platform version of the popular Entity Framework data access technology.

EF Core is an object-relational mapper (O/RM) that enables .NET developers to work with a database using .NET objects. It eliminates the need for most of the data-access code that developers usually need to write. EF Core supports many database engines, see Database Providers for details.

If you like to learn by writing code, we’d recommend one of our Getting Started guides to get you started with EF Core.


Latest version: EF Core 2.0

If you are familiar with EF Core and want to jump straight into the details of the new version:


	New features in EF Core 2.0

	Upgrading existing applications to EF Core 2.0






Get Entity Framework Core

Install the NuGet package [https://docs.nuget.org/ndocs/quickstart/use-a-package] for the database provider you want to use. E.g. to install the SQL Server provider in cross-platform development using dotnet tool in the command line:

dotnet add package Microsoft.EntityFrameworkCore.SqlServer





Or in Visual Studio, using the Package Manager Console:

Install-Package Microsoft.EntityFrameworkCore.SqlServer





See Database Providers for information on available providers and Installing EF Core for more detailed installation steps.




The Model

With EF Core, data access is performed using a model. A model is made up of entity classes and a derived context that represents a session with the database, allowing you to query and save data. See Creating a Model to learn more.

You can generate a model from an existing database, hand code a model to match your database, or use EF Migrations to create a database from your model (and evolve it as your model changes over time).

using Microsoft.EntityFrameworkCore;
using System.Collections.Generic;

namespace Intro
{
    public class BloggingContext : DbContext
    {
        public DbSet<Blog> Blogs { get; set; }
        public DbSet<Post> Posts { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            optionsBuilder.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=MyDatabase;Trusted_Connection=True;");
        }
    }

    public class Blog
    {
        public int BlogId { get; set; }
        public string Url { get; set; }
        public int Rating { get; set; }
        public List<Post> Posts { get; set; }
    }

    public class Post
    {
        public int PostId { get; set; }
        public string Title { get; set; }
        public string Content { get; set; }

        public int BlogId { get; set; }
        public Blog Blog { get; set; }
    }
}








Querying

Instances of your entity classes are retrieved from the database using Language Integrated Query (LINQ). See Querying Data to learn more.

using (var db = new BloggingContext())
{
    var blogs = db.Blogs
        .Where(b => b.Rating > 3)
        .OrderBy(b => b.Url)
        .ToList();
}








Saving Data

Data is created, deleted, and modified in the database using instances of your entity classes. See Saving Data to learn more.

using (var db = new BloggingContext())
{
    var blog = new Blog { Url = "http://sample.com" };
    db.Blogs.Add(blog);
    db.SaveChanges();
}
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Saving Data

Each context instance has a ChangeTracker that is responsible for keeping track of changes that need to be written to the database. As you make changes to instances of your entity classes, these changes are recorded in the ChangeTracker and then written to the database when you call SaveChanges. The database provider is responsible for translating the changes into database-specific operations (e.g. INSERT, UPDATE, and DELETE commands for a relational database).
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Setting Explicit Values for Generated Properties

A generated property is a property whose value is generated (either by EF or the database) when the entity is added and/or updated. See Generated Properties for more information.

There may be situations where you want to set an explicit value for a generated property, rather than having one generated.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/ExplicitValuesGenerateProperties/] on GitHub.



The model

The model used in this article contains a single Employee entity.

[!code-csharpMain]




Saving an explicit value during add

The Employee.EmploymentStarted property is configured to have values generated by the database for new entities (using a default value).

[!code-csharpMain]

The following code inserts two employees into the database.


	For the first, no value is assigned to Employee.EmploymentStarted property, so it remains set to the CLR default value for DateTime.

	For the second, we have set an explicit value of 1-Jan-2000.



[!code-csharpMain]

Output shows that the database generated a value for the first employee and our explicit value was used for the second.

1: John Doe, 1/26/2017 12:00:00 AM
2: Jane Doe, 1/1/2000 12:00:00 AM






Explicit values into SQL Server IDENTITY columns

By convention the Employee.EmployeeId property is a store generated IDENTITY column.

For most situations, the approach shown above will work for key properties. However, to insert explicit values into a SQL Server IDENTITY column, you need to manually enable IDENTITY_INSERT before calling SaveChanges().


[!NOTE]We have a feature request [https://github.com/aspnet/EntityFramework/issues/703] on our backlog to do this automatically within the SQL Server provider.


[!code-csharpMain]

Output shows that the supplied ids were saved to the database.

100: John Doe
101: Jane Doe










Setting an explicit value during update

The Employee.LastPayRaise property is configured to have values generated by the database during updates.

[!code-csharpMain]


[!NOTE]By default, EF Core will throw an exception if you try to save an explicit value for a property that is configured to be generated during update. To avoid this, you need to drop down to the lower level metadata API and set the AfterSaveBehavior (as shown above).



[!NOTE]Changes in EF Core 2.0: In previous releases the after-save behavior was controlled through the IsReadOnlyAfterSave flag. This flag has been obsoleted and replaced by AfterSaveBehavior.


There is also a trigger in the database to generate values for the LastPayRaise column during UPDATE operations.

[!code-sqlMain]

The following code increases the salary of two employees in the database.


	For the first, no value is assigned to Employee.LastPayRaise property, so it remains set to null.

	For the second, we have set an explicit value of one week ago (back dating the pay raise).



[!code-csharpMain]

Output shows that the database generated a value for the first employee and our explicit value was used for the second.

1: John Doe, 1/26/2017 12:00:00 AM
2: Jane Doe, 1/19/2017 12:00:00 AM
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Using Transactions

Transactions allow several database operations to be processed in an atomic manner. If the transaction is committed, all of the operations are successfully applied to the database. If the transaction is rolled back, none of the operations are applied to the database.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/Transactions/] on GitHub.



Default transaction behavior

By default, if the database provider supports transactions, all changes in a single call to SaveChanges() are applied in a transaction. If any of the changes fail, then the transaction is rolled back and none of the changes are applied to the database. This means that SaveChanges() is guaranteed to either completely succeed, or leave the database unmodified if an error occurs.

For most applications, this default behavior is sufficient. You should only manually control transactions if your application requirements deem it necessary.




Controlling transactions

You can use the DbContext.Database API to begin, commit, and rollback transactions. The following example shows two SaveChanges() operations and a LINQ query being executed in a single transaction.

Not all database providers support transactions. Some providers may throw or no-op when transaction APIs are called.


``` csharp
        using (var context = new BloggingContext())
        {
            using (var transaction = context.Database.BeginTransaction())
            {
                try
                {
                    context.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/dotnet" });
                    context.SaveChanges();                context.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/visualstudio" });
                context.SaveChanges();

                var blogs = context.Blogs
                    .OrderBy(b => b.Url)
                    .ToList();

                // Commit transaction if all commands succeed, transaction will auto-rollback
                // when disposed if either commands fails
                transaction.Commit();
            }
            catch (Exception)
            {
                // TODO: Handle failure
            }
        }
    }






## Cross-context transaction (relational databases only)

You can also share a transaction across multiple context instances. This functionality is only available when using a relational database provider because it requires the use of `DbTransaction` and `DbConnection`, which are specific to relational databases.

To share a transaction, the contexts must share both a `DbConnection` and a `DbTransaction`.

### Allow connection to be externally provided

Sharing a `DbConnection` requires the ability to pass a connection into a context when constructing it.

The easiest way to allow `DbConnection` to be externally provided, is to stop using the `DbContext.OnConfiguring` method to configure the context and externally create `DbContextOptions` and pass them to the context constructor.

> [!TIP]  
> `DbContextOptionsBuilder` is the API you used in `DbContext.OnConfiguring` to configure the context, you are now going to use it externally to create `DbContextOptions`.

<!-- [!code-csharp[Main](samples/core/Saving/Saving/Transactions/SharingTransaction/Sample.cs?highlight=3,4,5)] -->
``` csharp
    public class BloggingContext : DbContext
    {
        public BloggingContext(DbContextOptions<BloggingContext> options)
            : base(options)
        { }

        public DbSet<Blog> Blogs { get; set; }
    }





An alternative is to keep using DbContext.OnConfiguring, but accept a DbConnection that is saved and then used in DbContext.OnConfiguring.

public class BloggingContext : DbContext
{
    private DbConnection _connection;

    public BloggingContext(DbConnection connection)
    {
      _connection = connection;
    }

    public DbSet<Blog> Blogs { get; set; }

    protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
    {
        optionsBuilder.UseSqlServer(_connection);
    }
}






Share connection and transaction

You can now create multiple context instances that share the same connection. Then use the DbContext.Database.UseTransaction(DbTransaction) API to enlist both contexts in the same transaction.


``` csharp
        var options = new DbContextOptionsBuilder()
            .UseSqlServer(new SqlConnection(connectionString))
            .Options;    using (var context1 = new BloggingContext(options))
    {
        using (var transaction = context1.Database.BeginTransaction())
        {
            try
            {
                context1.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/dotnet" });
                context1.SaveChanges();

                using (var context2 = new BloggingContext(options))
                {
                    context2.Database.UseTransaction(transaction.GetDbTransaction());

                    var blogs = context2.Blogs
                        .OrderBy(b => b.Url)
                        .ToList();
                }

                // Commit transaction if all commands succeed, transaction will auto-rollback
                // when disposed if either commands fails
                transaction.Commit();
            }
            catch (Exception)
            {
                // TODO: Handle failure
            }
        }
    }






## Using external DbTransactions (relational databases only)

If you are using multiple data access technologies to access a relational database, you may want to share a transaction between operations performed by these different technologies.

The following example, shows how to perform an ADO.NET SqlClient operation and an Entity Framework Core operation in the same transaction.

<!-- [!code-csharp[Main](samples/core/Saving/Saving/Transactions/ExternalDbTransaction/Sample.cs?highlight=4,10,21,26,27,28)] -->
``` csharp
        var connection = new SqlConnection(connectionString);
        connection.Open();

        using (var transaction = connection.BeginTransaction())
        {
            try
            {
                // Run raw ADO.NET command in the transaction
                var command = connection.CreateCommand();
                command.Transaction = transaction;
                command.CommandText = "DELETE FROM dbo.Blogs";
                command.ExecuteNonQuery();

                // Run an EF Core command in the transaction
                var options = new DbContextOptionsBuilder<BloggingContext>()
                    .UseSqlServer(connection)
                    .Options;

                using (var context = new BloggingContext(options))
                {
                    context.Database.UseTransaction(transaction);
                    context.Blogs.Add(new Blog { Url = "http://blogs.msdn.com/dotnet" });
                    context.SaveChanges();
                }

                // Commit transaction if all commands succeed, transaction will auto-rollback
                // when disposed if either commands fails
                transaction.Commit();
            }
            catch (System.Exception)
            {
                // TODO: Handle failure
            }
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🔧 Disconnected Entities


[!NOTE]This topic hasn’t been written yet! You can track the status of this issue [https://github.com/aspnet/EntityFramework.Docs/issues/126] through our public GitHub issue tracker. Learn how you can contribute [https://github.com/aspnet/EntityFramework.Docs/blob/master/CONTRIBUTING.md] on GitHub.
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Basic Save

Learn how to add, modify, and remove data using your context and entity classes.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/Basics/] on GitHub.



Adding Data

Use the DbSet.Add method to add new instances of your entity classes. The data will be inserted in the database when you call SaveChanges.

[!code-csharpMain]




Updating Data

EF will automatically detect changes made to an existing entity that is tracked by the context. This includes entities that you load/query from the database, and entities that were previously added and saved to the database.

Simply modify the values assigned to properties and then call SaveChanges.

[!code-csharpMain]




Deleting Data

Use the DbSet.Remove method to delete instances of you entity classes.

If the entity already exists in the database, it will be deleted during SaveChanges. If the entity has not yet been saved to the database (i.e. it is tracked as added) then it will be removed from the context and will no longer be inserted when SaveChanges is called.

[!code-csharpMain]




Multiple Operations in a single SaveChanges

You can combine multiple Add/Update/Remove operations into a single call to SaveChanges.


[!NOTE]For most database providers, SaveChanges is transactional. This means  all the operations will either succeed or fail and the operations will never be left partially applied.


[!code-csharpMain]
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Saving Related Data

In addition to isolated entities, you can also make use of the relationships defined in your model.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/RelatedData/] on GitHub.



Adding a graph of new entities

If you create several new related entities, adding one of them to the context will cause the others to be added too.

In the following example, the blog and three related posts are all inserted into the database. The posts are found and added, because they are reachable via the Blog.Posts navigation property.

[!code-csharpMain]




Adding a related entity

If you reference a new entity from the navigation property of an entity that is already tracked by the context, the entity will be discovered and inserted into the database.

In the following example, the post entity is inserted because it is added to the Posts property of the blog entity which was fetched from the database.

[!code-csharpMain]




Changing relationships

If you change the navigation property of an entity, the corresponding changes will be made to the foreign key column in the database.

In the following example, the post entity is updated to belong to the new blog entity because its Blog navigation property is set to point to blog. Note that blog will also be inserted into the database because it is a new entity that is referenced by the navigation property of an entity that is already tracked by the context (post).

[!code-csharpMain]




Removing relationships

You can remove a relationship by setting a reference navigation to null, or removing the related entity from a collection navigation.

Removing a relationship can have side effects on the dependent entity, according to the cascade delete behavior configured in the relationship.

By default, for required relationships, a cascade delete behavior is configured and the child/dependent entity will be deleted from the database. For optional relationships, cascade delete is not configured by default, but the foreign key property will be set to null.

See Required and Optional Relationships to learn about how the requiredness of relationships can be configured.

See Cascade Delete for more details on how cascade delete behaviors work, how they can be configured explicitly and  how they are selected by convention.

In the following example, a cascade delete is configured on the relationship between Blog and Post, so the post entity is deleted from the database.

[!code-csharpMain]
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Handling Concurrency

If a property is configured as a concurrency token then EF will check that no other user has modified that value in the database when saving changes to that record.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/Concurrency/] on GitHub.



How concurrency handling works in EF Core

For a detailed description of how concurrency handling works in Entity Framework Core, see Concurrency Tokens.




Resolving concurrency conflicts

Resolving a concurrency conflict involves using an algorithm to merge the pending changes from the current user with the changes made in the database. The exact approach will vary based on your application, but a common approach is to display the values to the user and have them decide the correct values to be stored in the database.

There are three sets of values available to help resolve a concurrency conflict.


	Current values are the values that the application was attempting to write to the database.

	Original values are the values that were originally retrieved from the database, before any edits were made.

	Database values are the values currently stored in the database.



To handle a concurrency conflict, catch a DbUpdateConcurrencyException during SaveChanges(), use DbUpdateConcurrencyException.Entries to prepare a new set of changes for the affected entities, and then retry the SaveChanges() operation.

In the following example, Person.FirstName and Person.LastName are setup as concurrency token. There is a // TODO: comment in the location where you would include application specific logic to choose the value to be saved to the database.


``` csharp
using Microsoft.EntityFrameworkCore;
using System;
using System.ComponentModel.DataAnnotations;
using System.Linq;namespace EFSaving.Concurrency
{
public class Sample
{
public static void Run()
{
// Ensure database is created and has a person in it
using (var context = new PersonContext())
{
context.Database.EnsureDeleted();
context.Database.EnsureCreated();

            context.People.Add(new Person { FirstName = "John", LastName = "Doe" });
            context.SaveChanges();
        }

        using (var context = new PersonContext())
        {
            // Fetch a person from database and change phone number
            var person = context.People.Single(p => p.PersonId == 1);
            person.PhoneNumber = "555-555-5555";

            // Change the persons name in the database (will cause a concurrency conflict)
            context.Database.ExecuteSqlCommand("UPDATE dbo.People SET FirstName = 'Jane' WHERE PersonId = 1");

            try
            {
                // Attempt to save changes to the database
                context.SaveChanges();
            }
            catch (DbUpdateConcurrencyException ex)
            {
                foreach (var entry in ex.Entries)
                {
                    if (entry.Entity is Person)
                    {
                        // Using a NoTracking query means we get the entity but it is not tracked by the context
                        // and will not be merged with existing entities in the context.
                        var databaseEntity = context.People.AsNoTracking().Single(p => p.PersonId == ((Person)entry.Entity).PersonId);
                        var databaseEntry = context.Entry(databaseEntity);

                        foreach (var property in entry.Metadata.GetProperties())
                        {
                            var proposedValue = entry.Property(property.Name).CurrentValue;
                            var originalValue = entry.Property(property.Name).OriginalValue;
                            var databaseValue = databaseEntry.Property(property.Name).CurrentValue;

                            // TODO: Logic to decide which value should be written to database
                            // entry.Property(property.Name).CurrentValue = <value to be saved>;

                            // Update original values to
                            entry.Property(property.Name).OriginalValue = databaseEntry.Property(property.Name).CurrentValue;
                        }
                    }
                    else
                    {
                        throw new NotSupportedException("Don't know how to handle concurrency conflicts for " + entry.Metadata.Name);
                    }
                }

                // Retry the save operation
                context.SaveChanges();
            }
        }
    }

    public class PersonContext : DbContext
    {
        public DbSet<Person> People { get; set; }

        protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
        {
            optionsBuilder.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=EFSaving.Concurrency;Trusted_Connection=True;");
        }
    }

    public class Person
    {
        public int PersonId { get; set; }

        [ConcurrencyCheck]
        public string FirstName { get; set; }

        [ConcurrencyCheck]
        public string LastName { get; set; }

        public string PhoneNumber { get; set; }
    }

}





}
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Cascade Delete

Cascade delete is commonly used in database terminology to describe a characteristic that allows the deletion of a row to automatically trigger the deletion of related rows. A closely related concept also covered by EF Core delete behaviors is the automatic deletion of a child entity when it’s relationship to a parent has been severed–this i commonly known as “deleting orphans”.

EF Core implements several different delete behaviors and allows for the configuration of the delete behaviors of individual relationships. EF Core also implements conventions that automatically configure useful default delete behaviors for each relationship based on the [requiredness of the relationship] (../modeling/relationships.md#required-and-optional-relationships).


Delete behaviors

Delete behaviors are defined in the DeleteBehavior enumerator type and can be passed to the OnDelete fluent API to control whether the deletion of a principal/parent entity or the severing of the relationship to dependent/child entities should have a side effect on the dependent/child entities.

There are three actions EF can take when a principal/parent entity is deleted or the relationship to the child is severed:


	The child/dependent can be deleted

	The child’s foreign key values can be set to null

	The child remains unchanged




[!NOTE]The delete behavior configured in the EF Core model is only applied when the principal entity is deleted using EF Core and the dependent entities are loaded in memory (i.e. for tracked dependents). A corresponding cascade behavior needs to be setup in the database to ensure data that is not being tracked by the context has the necessary action applied. If you use EF Core to create the database, this cascade behavior will be setup for you.


For the second action above, setting a foreign key value to null is not valid if foreign key is not nullable. (A non-nullable foreign key is equivalent to a required relationship.) In these cases, EF Core tracks that the foreign key property has been marked as null until SaveChanges is called, at which time an exception is thrown because the change cannot be persisted to the database. This is similar to getting a constraint violation from the database.

There are four delete behaviors, as listed in the tables below. For optional relationships (nullable foreign key) it is possible to save a null foreign key value, which results in the following effects:

| Behavior Name | Effect on dependent/child in memory | Effect on dependent/child in database
|-|-|-
| Cascade | Entities are deleted | Entities are deleted
| ClientSetNull (Default) | Foreign key properties are set to null | None
| SetNull | Foreign key properties are set to null | Foreign key properties are set to null
| Restrict | None | None

For required relationships (non-nullable foreign key) it is not possible to save a null foreign key value, which results in the following effects:

| Behavior Name | Effect on dependent/child in memory | Effect on dependent/child in database
|-|-|-
| Cascade (Default) | Entities are deleted | Entities are deleted
| ClientSetNull | SaveChanges throws | None
| SetNull | SaveChanges throws | SaveChanges throws
| Restrict | None | None

In the tables above, None can result in a constraint violation. For example, if a principal/child entity is deleted but no action is taken to change the foreign key of a dependent/child, then the database will likely throw on SaveChanges due to a foreign constraint violation.

At a high level:


	If you have entities that cannot exist without a parent, and you want EF to take care for deleting the children automatically, then use Cascade.
	Entities that cannot exist without a parent usually make use of required relationships, for which Cascade is the default.





	If you have entities that may or may not have a parent, and you want EF to take care of nulling out the foreign key for you, then use ClientSetNull
	Entities that can exist without a parent usually make use of optional relationships, for which ClientSetNull is the default.

	If you want the database to also try to propagate null values to child foreign keys even when the child entity is not loaded, then use SetNull. However, note that the database must support this, and configuring the database like this can result in other restrictions, which in practice often makes this option impractical. This is why SetNull is not the default.





	If you don’t want EF Core to ever delete an entity automatically or null out the foreign key automatically, then use Restrict. Note that this requires that your code keep child entities and their foreign key values in sync manually otherwise constraint exceptions will be thrown.




[!NOTE]
In EF Core, unlike EF6, cascading effects do not happen immediately, but instead only when SaveChanges is called.



[!NOTE]Changes in EF Core 2.0: In previous releases, Restrict would cause optional foreign key properties in tracked dependent entities to be set to null, and was the default delete behavior for optional relationships. In EF Core 2.0, the ClientSetNull was introduced to represent that behavior and became the default for optional relationships. The behavior of Restrict was adjusted to never have any side effects on dependent entities.





Entity deletion examples

The code below is part of a sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/CascadeDelete/] that can be downloaded an run. The sample shows what happens for each delete behavior for both optional and required relationships when a parent entity is deleted.

[!code-csharpMain]

Let’s walk through each variation to understand what is happening.


DeleteBehavior.Cascade with required or optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After deleting blog '1':
    Blog '1' is in state Deleted with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  Saving changes:
    DELETE FROM [Posts] WHERE [PostId] = 1
    DELETE FROM [Posts] WHERE [PostId] = 2
    DELETE FROM [Blogs] WHERE [BlogId] = 1

  After SaveChanges:
    Blog '1' is in state Detached with 2 posts referenced.
      Post '1' is in state Detached with FK '1' and no reference to a blog.
      Post '1' is in state Detached with FK '1' and no reference to a blog.






	Blog is marked as Deleted

	Posts initially remain Unchanged since cascades do not happen until SaveChanges

	SaveChanges sends deletes for both dependents/children (posts) and then the principal/parent (blog)

	After saving, all entities are detached since they have now been deleted from the database






DeleteBehavior.ClientSetNull or DeleteBehavior.SetNull with required relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After deleting blog '1':
    Blog '1' is in state Deleted with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  Saving changes:
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 1

  SaveChanges threw DbUpdateException: Cannot insert the value NULL into column 'BlogId', table 'EFSaving.CascadeDelete.dbo.Posts'; column does not allow nulls. UPDATE fails. The statement has been terminated.






	Blog is marked as Deleted

	Posts initially remain Unchanged since cascades do not happen until SaveChanges

	SaveChanges attempts to set the post FK to null, but this fails because the FK is not nullable






DeleteBehavior.ClientSetNull or DeleteBehavior.SetNull with optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After deleting blog '1':
    Blog '1' is in state Deleted with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  Saving changes:
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 1
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 2
    DELETE FROM [Blogs] WHERE [BlogId] = 1

  After SaveChanges:
    Blog '1' is in state Detached with 2 posts referenced.
      Post '1' is in state Unchanged with FK 'null' and no reference to a blog.
      Post '1' is in state Unchanged with FK 'null' and no reference to a blog.






	Blog is marked as Deleted

	Posts initially remain Unchanged since cascades do not happen until SaveChanges

	SaveChanges attempts sets the FK of both dependents/children (posts) to null before deleting the principal/parent (blog)

	After saving, the principal/parent (blog) is deleted, but the dependents/children (posts) are still tracked

	The tracked dependents/children (posts) now have null FK values and their reference to the deleted principal/parent (blog) has been removed






DeleteBehavior.Restrict with required or optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After deleting blog '1':
    Blog '1' is in state Deleted with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  Saving changes:
  SaveChanges threw InvalidOperationException: The association between entity types 'Blog' and 'Post' has been severed but the foreign key for this relationship cannot be set to null. If the dependent entity should be deleted, then setup the relationship to use cascade deletes.






	Blog is marked as Deleted

	Posts initially remain Unchanged since cascades do not happen until SaveChanges

	Since Restrict tells EF to not automatically set the FK to null, it remains non-null and SaveChanges throws without saving








Delete orphans examples

The code below is part of a sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Saving/Saving/CascadeDelete/] that can be downloaded an run. The sample shows what happens for each delete behavior for both optional and required relationships when the relationship between a parent/principal and its children/dependents is severed. In this example, the relationship is severed by removing the dependents/children (posts) from the collection navigation property on the principal/parent (blog). However, the behavior is the same if the reference from dependent/child to principal/parent is instead nulled out.

[!code-csharpMain]

Let’s walk through each variation to understand what is happening.


DeleteBehavior.Cascade with required or optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After making posts orphans:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Modified with FK '1' and no reference to a blog.
      Post '1' is in state Modified with FK '1' and no reference to a blog.

  Saving changes:
    DELETE FROM [Posts] WHERE [PostId] = 1
    DELETE FROM [Posts] WHERE [PostId] = 2

  After SaveChanges:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Detached with FK '1' and no reference to a blog.
      Post '1' is in state Detached with FK '1' and no reference to a blog.






	Posts are marked as Modified because severing the relationship caused the FK to be marked as null
	If the FK is not nullable, then the actual value will not change even though it is marked as null





	SaveChanges sends deletes for dependents/children (posts)

	After saving, the dependents/children (posts) are detached since they have now been deleted from the database






DeleteBehavior.ClientSetNull or DeleteBehavior.SetNull with required relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After making posts orphans:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Modified with FK 'null' and no reference to a blog.
      Post '1' is in state Modified with FK 'null' and no reference to a blog.

  Saving changes:
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 1

  SaveChanges threw DbUpdateException: Cannot insert the value NULL into column 'BlogId', table 'EFSaving.CascadeDelete.dbo.Posts'; column does not allow nulls. UPDATE fails. The statement has been terminated.






	Posts are marked as Modified because severing the relationship caused the FK to be marked as null
	If the FK is not nullable, then the actual value will not change even though it is marked as null





	SaveChanges attempts to set the post FK to null, but this fails because the FK is not nullable






DeleteBehavior.ClientSetNull or DeleteBehavior.SetNull with optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After making posts orphans:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Modified with FK 'null' and no reference to a blog.
      Post '1' is in state Modified with FK 'null' and no reference to a blog.

  Saving changes:
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 1
    UPDATE [Posts] SET [BlogId] = NULL WHERE [PostId] = 2

  After SaveChanges:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK 'null' and no reference to a blog.
      Post '1' is in state Unchanged with FK 'null' and no reference to a blog.






	Posts are marked as Modified because severing the relationship caused the FK to be marked as null
	If the FK is not nullable, then the actual value will not change even though it is marked as null





	SaveChanges sets the FK of both dependents/children (posts) to null

	After saving, the dependents/children (posts) now have null FK values and their reference to the deleted principal/parent (blog) has been removed






DeleteBehavior.Restrict with required or optional relationship

  After loading entities:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.
      Post '1' is in state Unchanged with FK '1' and reference to blog '1'.

  After making posts orphans:
    Blog '1' is in state Unchanged with 2 posts referenced.
      Post '1' is in state Modified with FK '1' and no reference to a blog.
      Post '1' is in state Modified with FK '1' and no reference to a blog.

  Saving changes:
  SaveChanges threw InvalidOperationException: The association between entity types 'Blog' and 'Post' has been severed but the foreign key for this relationship cannot be set to null. If the dependent entity should be deleted, then setup the relationship to use cascade deletes.






	Posts are marked as Modified because severing the relationship caused the FK to be marked as null
	If the FK is not nullable, then the actual value will not change even though it is marked as null





	Since Restrict tells EF to not automatically set the FK to null, it remains non-null and SaveChanges throws without saving








Cascading to untracked entities

When you call SaveChanges, the cascade delete rules will be applied to any entities that are being tracked by the context. This is the situation in all the examples shown above, which is why SQL was generated to delete both the principal/parent (blog) and all the dependents/children (posts):

    DELETE FROM [Posts] WHERE [PostId] = 1
    DELETE FROM [Posts] WHERE [PostId] = 2
    DELETE FROM [Blogs] WHERE [BlogId] = 1





If only the principal is loaded–for example, when a query is made for a blog without an Include(b => b.Posts) to also include posts–then SaveChanges will only generate SQL to delete the principal/parent:

    DELETE FROM [Blogs] WHERE [BlogId] = 1





The dependents/children (posts) will only be deleted if the database has a corresponding cascade behavior configured. If you use EF to create the database, this cascade behavior will be setup for you.
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Asynchronous Saving

Asynchronous saving avoids blocking a thread while the changes are written to the database. This can be useful to avoid freezing the UI of a thick-client application. Asynchronous operations can also increase throughput in a web application, where the thread can be freed up to service other requests while the database operation completes. For more information, see Asynchronous Programming in C# [https://docs.microsoft.com/dotnet/csharp/async].


[!WARNING]EF Core does not support multiple parallel operations being run on the same context instance. You should always wait for an operation to complete before beginning the next operation. This is typically done by using the await keyword on each asynchronous operation.


Entity Framework Core provides DbContext.SaveChangesAsync() as an asynchronous alternative to DbContext.SaveChanges().

[!code-csharpMain]
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Getting Started with Entity Framework Core


Installing EF Core

A summary of the steps necessary to add EF Core to your application in different platforms and popular IDEs.




Step-by-step Tutorials

These 101 tutorials require no previous knowledge of Entity Framework Core or a particular IDE. They will take you step-by-step through creating a simple application that queries and saves data from a database. We have provided tutorials to get you started on various operating systems and application types.

Entity Framework Core can create a model based on an existing database, or create a database for you based on your model. There are tutorials that demonstrate both of these approaches.


[!NOTE]These tutorials and the accompanying samples have been updated to use EF Core 2.0 (with the exception of the UWP tutorial, that still uses EF Core 1.1). However, in the majority of cases it should be possible to create applications that use previous releases, with minimal modification to the instructions.
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Getting Started with EF Core on ASP.NET Core

These 101 tutorials require no previous knowledge of Entity Framework Core or Visual Studio. They will take you step-by-step through creating a simple ASP.NET Core application that queries and saves data from a database. You can chose a tutorial that creates a model based on an existing database, or creates a database for you based on your model.

You can find the ASP.NET Core documentation at docs.asp.net [https://docs.asp.net].


[!NOTE]These tutorials and the accompanying samples have been updated to use EF Core 2.0 (with the exception of the UWP tutorial, that still uses EF Core 1.1). However, in the majority of cases it should be possible to create applications that use previous releases, with minimal modification to the instructions.
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Getting Started with EF Core on ASP.NET Core with an Existing Database


[!IMPORTANT]The .NET Core SDK [https://www.microsoft.com/net/download/core] no longer supports project.json or Visual Studio 2015. Everyone doing .NET Core development is encouraged to migrate from project.json to csproj [https://docs.microsoft.com/dotnet/articles/core/migration/] and Visual Studio 2017 [https://www.visualstudio.com/downloads/].


In this walkthrough, you will build an ASP.NET Core MVC application that performs basic data access using Entity Framework. You will use reverse engineering to create an Entity Framework model based on an existing database.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/AspNetCore/EFGetStarted.AspNetCore.ExistingDb] on GitHub.



Prerequisites

The following prerequisites are needed to complete this walkthrough:


	Visual Studio 2017 15.3 [https://www.visualstudio.com/downloads/] with these workloads:
	ASP.NET and web development (under Web & Cloud)

	.NET Core cross-platform development (under Other Toolsets)





	.NET Core 2.0 SDK [https://www.microsoft.com/net/download/core].

	Blogging database




Blogging database

This tutorial uses a Blogging database on your LocalDb instance as the existing database.


[!TIP]If you have already created the Blogging database as part of another tutorial, you can skip these steps.



	Open Visual Studio

	Tools -> Connect to Database...

	Select Microsoft SQL Server and click Continue

	Enter (localdb)\mssqllocaldb as the Server Name

	Enter master as the Database Name and click OK

	The master database is now displayed under Data Connections in Server Explorer

	Right-click on the database in Server Explorer and select New Query

	Copy the script, listed below, into the query editor

	Right-click on the query editor and select Execute



[!code-sqlMain]






Create a new project


	Open Visual Studio 2017

	File -> New -> Project...

	From the left menu select Installed -> Templates -> Visual C# -> Web

	Select the ASP.NET Core Web Application (.NET Core) project template

	Enter EFGetStarted.AspNetCore.ExistingDb as the name and click OK

	Wait for the New ASP.NET Core Web Application dialog to appear

	Under ASP.NET Core Templates 2.0 select the Web Application (Model-View-Controller)

	Ensure that Authentication is set to No Authentication

	Click OK






Install Entity Framework

To use EF Core, install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools > NuGet Package Manager > Package Manager Console

	Run Install-Package Microsoft.EntityFrameworkCore.SqlServer



We will be using some Entity Framework Tools to create a model from the database. So we will install the tools package as well:


	Run Install-Package Microsoft.EntityFrameworkCore.Tools



We will be using some ASP.NET Core Scaffolding tools to create controllers and views later on. So we will install this design package as well:


	Run Install-Package Microsoft.VisualStudio.Web.CodeGeneration.Design






Reverse engineer your model

Now it’s time to create the EF model based on your existing database.


	Tools –> NuGet Package Manager –> Package Manager Console

	Run the following command to create a model from the existing database. If you receive an error stating The term 'Scaffold-DbContext' is not recognized as the name of a cmdlet, then close and reopen Visual Studio.



Scaffold-DbContext "Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;" Microsoft.EntityFrameworkCore.SqlServer -OutputDir Models






[!TIP]You can specify which tables you want to generate entities for by adding the -Tables argument to the command above. E.g. -Tables Blog,Post.


The reverse engineer process created entity classes (Blog.cs & Post.cs) and a derived context (BloggingContext.cs) based on the schema of the existing database.

The entity classes are simple C# objects that represent the data you will be querying and saving.

[!code-csharpMain]

The context represents a session with the database and allows you to query and save instances of the entity classes.


 ``` csharp
public partial class BloggingContext : DbContext
{
    public virtual DbSet Blog { get; set; }
    public virtual DbSet Post { get; set; }protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
{
    if (!optionsBuilder.IsConfigured)
    {
        #warning To protect potentially sensitive information in your connection string, you should move it out of source code. See http://go.microsoft.com/fwlink/?LinkId=723263 for guidance on storing connection strings.
        optionsBuilder.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;");
    }
}

protected override void OnModelCreating(ModelBuilder modelBuilder)
{
    modelBuilder.Entity<Blog>(entity =>
    {
        entity.Property(e => e.Url).IsRequired();
    });

    modelBuilder.Entity<Post>(entity =>
    {
        entity.HasOne(d => d.Blog)
            .WithMany(p => p.Post)
            .HasForeignKey(d => d.BlogId);
    });
}





}


## Register your context with dependency injection

The concept of dependency injection is central to ASP.NET Core. Services (such as `BloggingContext`) are registered with dependency injection during application startup. Components that require these services (such as your MVC controllers) are then provided these services via constructor parameters or properties. For more information on dependency injection see the [Dependency Injection](http://docs.asp.net/en/latest/fundamentals/dependency-injection.html) article on the ASP.NET site.

### Remove inline context configuration

In ASP.NET Core, configuration is generally performed in **Startup.cs**. To conform to this pattern, we will move configuration of the database provider to **Startup.cs**.

* Open `Models\BloggingContext.cs`
* Delete the `OnConfiguring(...)` method

``` csharp
protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
{
    #warning To protect potentially sensitive information in your connection string, you should move it out of source code. See http://go.microsoft.com/fwlink/?LinkId=723263 for guidance on storing connection strings.
    optionsBuilder.UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;");
}






	Add the following constructor, which will allow configuration to be passed into the context by dependency injection



[!code-csharpMain]


Register and configure your context in Startup.cs

In order for our MVC controllers to make use of BloggingContext we are going to register it as a service.


	Open Startup.cs

	Add the following using statements at the start of the file



[!code-csharpMain]

Now we can use the AddDbContext(...) method to register it as a service.


	Locate the ConfigureServices(...) method

	Add the following code to register the context as a service



[!code-csharpMain]


[!TIP]In a real application you would typically put the connection string in a configuration file. For the sake of simplicity, we are defining it in code. For more information, see Connection Strings.
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Getting Started with EF Core on ASP.NET Core with a New database

In this walkthrough, you will build an ASP.NET Core MVC application that performs basic data access using Entity Framework Core. You will use migrations to create the database from your EF Core model. See Additional Resources for more Entity Framework Core tutorials.

This tutorial requires:


	Visual Studio 2017 15.3 [https://www.visualstudio.com/downloads/] with these workloads:
	ASP.NET and web development (under Web & Cloud)

	.NET Core cross-platform development (under Other Toolsets)





	.NET Core 2.0 SDK [https://www.microsoft.com/net/download/core].




[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/AspNetCore/EFGetStarted.AspNetCore.NewDb] on GitHub.



Create a new project in Visual Studio 2017


	File > New > Project

	From the left menu select Installed > Templates > Visual C# > .NET Core.

	Select ASP.NET Core Web Application.

	Enter EFGetStarted.AspNetCore.NewDb for the name and click OK.

	In the New ASP.NET Core Web Application dialog:
	Ensure the options .NET Core and ASP.NET Core 2.0 are selected in the drop down lists

	Select the Web Application (Model-View-Controller) project template

	Ensure that Authentication is set to No Authentication

	Click OK







Warning: If you use Individual User Accounts instead of None for Authentication then an Entity Framework Core model will be added to your project in Models\IdentityModel.cs. Using the techniques you will learn in this walkthrough, you can choose to add a second model, or extend this existing model to contain your entity classes.




Install Entity Framework Core

Install the package for the EF Core database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools > NuGet Package Manager > Package Manager Console

	Run Install-Package Microsoft.EntityFrameworkCore.SqlServer



We will be using some Entity Framework Core Tools to create a database from your EF Core model. So we will install the tools package as well:


	Run Install-Package Microsoft.EntityFrameworkCore.Tools



We will be using some ASP.NET Core Scaffolding tools to create controllers and views later on. So we will install this design package as well:


	Run Install-Package Microsoft.VisualStudio.Web.CodeGeneration.Design






Create the model

Define a context and entity classes that make up the model:


	Right-click on the Models folder and select Add > Class.

	Enter Model.cs as the name and click OK.

	Replace the contents of the file with the following code:



[!code-csharpMain]

Note: In a real app you would typically put each class from your model in a separate file. For the sake of simplicity, we are putting all the classes in one file for this tutorial.




Register your context with dependency injection

Services (such as BloggingContext) are registered with dependency injection [http://docs.asp.net/en/latest/fundamentals/dependency-injection.html] during application startup. Components that require these services (such as your MVC controllers) are then provided these services via constructor parameters or properties.

In order for our MVC controllers to make use of BloggingContext we will register it as a service.


	Open Startup.cs

	Add the following using statements:



[!code-csharpMain]

Add the AddDbContext method to register it as a service:


	Add the following code to the ConfigureServices method:



[!code-csharpMain]

Note: A real app would gennerally put the connection string in a configuration file. For the sake of simplicity, we are defining it in code. See Connection Strings for more information.




Create your database

Once you have a model, you can use migrations [https://docs.microsoft.com/aspnet/core/data/ef-mvc/migrations#introduction-to-migrations] to create a database.


	Open the PMC:

Tools –> NuGet Package Manager –> Package Manager Console



	Run Add-Migration InitialCreate to scaffold a migration to create the initial set of tables for your model. If you receive an error stating The term 'add-migration' is not recognized as the name of a cmdlet, close and reopen Visual Studio.



	Run Update-Database to apply the new migration to the database. This command creates the database before applying migrations.








Create a controller

Enable scaffolding in the project:


	Right-click on the Controllers folder in Solution Explorer and select Add > Controller.

	Select Minimal Dependencies and click Add.

	You can ignore or delete the ScaffoldingReadMe.txt file.



Now that scaffolding is enabled, we can scaffold a controller for the Blog entity.


	Right-click on the Controllers folder in Solution Explorer and select Add > Controller.

	Select MVC Controller with views, using Entity Framework and click Ok.

	Set Model class to Blog and Data context class to BloggingContext.

	Click Add.






Run the application

Press F5 to run and test the app.


	Navigate to /Blogs

	Use the create link to create some blog entries. Test the details and delete links.



[image: image]

[image: image]




Additional Resources


	EF - New database with SQLite -  a cross-platform console EF tutorial.

	Introduction to ASP.NET Core MVC on Mac or Linux [https://docs.microsoft.com/aspnet/core/tutorials/first-mvc-app-xplat/index]

	Introduction to ASP.NET Core MVC with Visual Studio [https://docs.microsoft.com/aspnet/core/tutorials/first-mvc-app/index]

	Getting started with ASP.NET Core and Entity Framework Core using Visual Studio [https://docs.microsoft.com/aspnet/core/data/ef-mvc/index]
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Getting Started with EF Core on .NET Framework

These 101 tutorials require no previous knowledge of Entity Framework Core or Visual Studio. They will take you step-by-step through creating a simple .NET Framework Console Application that queries and saves data from a database. You can chose a tutorial that creates a model based on an existing database, or creates a database for you based on your model.

You can use the techniques learned in these tutorials in any application that targets the .NET Framework, including WPF and WinForms.


[!NOTE]These tutorials and the accompanying samples have been updated to use EF Core 2.0 (with the exception of the UWP tutorial, that still uses EF Core 1.1). However, in the majority of cases it should be possible to create applications that use previous releases, with minimal modification to the instructions.
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Getting started with EF Core on .NET Framework with an Existing Database

In this walkthrough, you will build a console application that performs basic data access against a Microsoft SQL Server database using Entity Framework. You will use reverse engineering to create an Entity Framework model based on an existing database.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/FullNet/ConsoleApp.ExistingDb] on GitHub.



Prerequisites

The following prerequisites are needed to complete this walkthrough:


	Visual Studio 2017 [https://www.visualstudio.com/downloads/]

	Latest version of NuGet Package Manager [https://dist.nuget.org/index.html]

	Latest version of Windows PowerShell [https://docs.microsoft.com/powershell/scripting/setup/installing-windows-powershell]

	Blogging database




Blogging database

This tutorial uses a Blogging database on your LocalDb instance as the existing database.


[!TIP]If you have already created the Blogging database as part of another tutorial, you can skip these steps.



	Open Visual Studio

	Tools > Connect to Database...

	Select Microsoft SQL Server and click Continue

	Enter (localdb)\mssqllocaldb as the Server Name

	Enter master as the Database Name and click OK

	The master database is now displayed under Data Connections in Server Explorer

	Right-click on the database in Server Explorer and select New Query

	Copy the script, listed below, into the query editor

	Right-click on the query editor and select Execute



[!code-sqlMain]






Create a new project


	Open Visual Studio

	File > New > Project...

	From the left menu select Templates > Visual C# > Windows

	Select the Console Application project template

	Ensure you are targeting .NET Framework 4.5.1 or later

	Give the project a name and click OK






Install Entity Framework

To use EF Core, install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools > NuGet Package Manager > Package Manager Console

	Run Install-Package Microsoft.EntityFrameworkCore.SqlServer



To enable reverse engineering from an existing database we need to install a couple of other packages too.


	Run Install-Package Microsoft.EntityFrameworkCore.Tools






Reverse engineer your model

Now it’s time to create the EF model based on your existing database.


	Tools –> NuGet Package Manager –> Package Manager Console

	Run the following command to create a model from the existing database



Scaffold-DbContext "Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;" Microsoft.EntityFrameworkCore.SqlServer





The reverse engineer process created entity classes and a derived context based on the schema of the existing database. The entity classes are simple C# objects that represent the data you will be querying and saving.


``` csharp
using System;
using System.Collections.Generic;namespace EFGetStarted.ConsoleApp.ExistingDb
{
public partial class Blog
{
public Blog()
{
Post = new HashSet();
}
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Getting started with EF Core on .NET Framework with a New Database

In this walkthrough, you will build a console application that performs basic data access against a Microsoft SQL Server database using Entity Framework. You will use migrations to create the database from your model.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/FullNet/ConsoleApp.NewDb] on GitHub.



Prerequisites

The following prerequisites are needed to complete this walkthrough:


	Visual Studio 2017 [https://www.visualstudio.com/downloads/]

	Latest version of NuGet Package Manager [https://dist.nuget.org/index.html]

	Latest version of Windows PowerShell [https://docs.microsoft.com/powershell/scripting/setup/installing-windows-powershell]






Create a new project


	Open Visual Studio

	File > New > Project...

	From the left menu select Templates > Visual C# > Windows Classic Desktop

	Select the Console App (.NET Framework) project template

	Ensure you are targeting .NET Framework 4.5.1 or later

	Give the project a name and click OK






Install Entity Framework

To use EF Core, install the package for the database provider(s) you want to target. This walkthrough uses SQL Server. For a list of available providers see Database Providers.


	Tools > NuGet Package Manager > Package Manager Console

	Run Install-Package Microsoft.EntityFrameworkCore.SqlServer



Later in this walkthrough we will also be using some Entity Framework Tools to maintain the database. So we will install the tools package as well.


	Run Install-Package Microsoft.EntityFrameworkCore.Tools






Create your model

Now it’s time to define a context and entity classes that make up your model.


	Project > Add Class...

	Enter Model.cs as the name and click OK

	Replace the contents of the file with the following code




``` csharp
using Microsoft.EntityFrameworkCore;
using System.Collections.Generic;namespace EFGetStarted.ConsoleApp
{
public class BloggingContext : DbContext
{
public DbSet Blogs { get; set; }
public DbSet Posts { get; set; }
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Getting Started with EF Core on .NET Core

These 101 tutorials require no previous knowledge of Entity Framework Core or Visual Studio. They will take you step-by-step through creating a simple .NET Core Console Application that queries and saves data from a database. The tutorials can be completed on any platform supported by .NET Core (Windows, OSX, Linux, etc.).

You can find the .NET Core documentation at docs.microsoft.com/dotnet/articles/core [https://docs.microsoft.com/dotnet/articles/core/].


[!NOTE]These tutorials and the accompanying samples have been updated to use EF Core 2.0 (with the exception of the UWP tutorial, that still uses EF Core 1.1). However, in the majority of cases it should be possible to create applications that use previous releases, with minimal modification to the instructions.
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Getting Started with EF Core on .NET Core Console App with a New database

In this walkthrough, you will create a .NET Core console app that performs basic data access against a SQLite database using Entity Framework Core. You will use migrations to create the database from your model. See ASP.NET Core - New database for a Visual Studio version using ASP.NET Core MVC.


[!NOTE]The .NET Core SDK [https://www.microsoft.com/net/download/core] no longer supports project.json or Visual Studio 2015. We recommend you migrate from project.json to csproj [https://docs.microsoft.com/dotnet/articles/core/migration/]. If you are using Visual Studio, we recommend you migrate to Visual Studio 2017 [https://www.visualstudio.com/downloads/].



[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/NetCore/ConsoleApp.SQLite] on GitHub.



Prerequisites

The following prerequisites are needed to complete this walkthrough:


	An operating system that supports .NET Core.

	The .NET Core SDK [https://www.microsoft.com/net/core] 2.0 (although the instructions can be used to create an application with a previous version with very few modifications).






Create a new project


	Create a new ConsoleApp.SQLite folder for your project and use the dotnet command to populate it with a .NET Core app.



mkdir ConsoleApp.SQLite
cd ConsoleApp.SQLite/
dotnet new console








Install Entity Framework Core

To use EF Core, install the package for the database provider(s) you want to target. This walkthrough uses SQLite. For a list of available providers see Database Providers.


	Install Microsoft.EntityFrameworkCore.Sqlite and Microsoft.EntityFrameworkCore.Design



dotnet add package Microsoft.EntityFrameworkCore.Sqlite
dotnet add package Microsoft.EntityFrameworkCore.Design






	Manually edit ConsoleApp.SQLite.csproj to add a DotNetCliToolReference to Microsoft.EntityFrameworkCore.Tools.DotNet:

<ItemGroup>
  <DotNetCliToolReference Include="Microsoft.EntityFrameworkCore.Tools.DotNet" Version="2.0.0" />
</ItemGroup>









Note: A future version of dotnet will support DotNetCliToolReferences via dotnet add tool

ConsoleApp.SQLite.csproj should now contain the following:

[!codeMain]

Note: The version numbers used above were correct at the time of publishing.


	Run dotnet restore to install the new packages.






Create the model

Define a context and entity classes that make up your model.


	Create a new Model.cs file with the following contents.



[!code-csharpMain]

Tip: In a real application you would put each class in a separate file and put the connection string in a configuration file. To keep the tutorial simple, we are putting everything in one file.




Create the database

Once you have a model, you can use migrations [https://docs.microsoft.com/aspnet/core/data/ef-mvc/migrations#introduction-to-migrations] to create a database.


	Run dotnet ef migrations add InitialCreate to scaffold a migration and create the initial set of tables for the model.

	Run dotnet ef database update to apply the new migration to the database. This command creates the database before applying migrations.




[!NOTE]When using relative paths with SQLite, the path will be relative to the application’s main assembly. In this sample, the main binary is bin/Debug/netcoreapp2.0/ConsoleApp.SQLite.dll, so the SQLite database will be in bin/Debug/netcoreapp2.0/blogging.db.





Use your model


	Open Program.cs and replace the contents with the following code:



[!code-csharpMain]


	Test the app:



dotnet run

One blog is saved to the database and the details of all blogs are displayed in the console.

ConsoleApp.SQLite>dotnet run
1 records saved to database

All blogs in database:
 - http://blogs.msdn.com/adonet






Changing the model:


	If you make changes to your model, you can use the dotnet ef migrations add command to scaffold a new migration [https://docs.microsoft.com/aspnet/core/data/ef-mvc/migrations#introduction-to-migrations]  to make the corresponding schema changes to the database. Once you have checked the scaffolded code (and made any required changes), you can use the dotnet ef database update command to apply the changes to the database.

	EF uses a __EFMigrationsHistory table in the database to keep track of which migrations have already been applied to the database.

	SQLite does not support all migrations (schema changes) due to limitations in SQLite. See SQLite Limitations. For new development, consider dropping the database and creating a new one rather than using migrations when your model changes.








Additional Resources


	.NET Core - New database with SQLite -  a cross-platform console EF tutorial.

	Introduction to ASP.NET Core MVC on Mac or Linux [https://docs.microsoft.com/aspnet/core/tutorials/first-mvc-app-xplat/index]

	Introduction to ASP.NET Core MVC with Visual Studio [https://docs.microsoft.com/aspnet/core/tutorials/first-mvc-app/index]

	Getting started with ASP.NET Core and Entity Framework Core using Visual Studio [https://docs.microsoft.com/aspnet/core/data/ef-mvc/index]
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Installing EF Core


Prerequisites

In order to develop .NET Core 2.0 applications (including ASP.NET Core 2.0 applications that target .NET Core) you will need to download and install a version of the .NET Core 2.0 SDK [https://www.microsoft.com/net/download/core] that is appropriate to your platform. This is true even if you have installed Visual Studio 2017 version 15.3.

In order to use EF Core 2.0 or any other .NET Standard 2.0 library with a .NET platforms besides .NET Core 2.0 (e.g. with .NET Framework 4.6.1 or greater) you will need a version of NuGet that is aware of the .NET Standard 2.0 and its compatible frameworks. Here are a few ways you can obtain this:


	Install Visual Studio 2017 version 15.3

	If you are using Visual Studio 2015, download and upgrade NuGet client to version 3.6.0 [https://www.nuget.org/downloads]



Projects created with previous versions of Visual Studio and targeting .NET Framework may need additional modifications in order to be compatible with .NET Standard 2.0 libraries:


	Edit the project file and make sure the following entry appears in the initial property group:

<AutoGenerateBindingRedirects>true</AutoGenerateBindingRedirects>







	For test projects, also make sure the following entry is present:

<GenerateBindingRedirectsOutputType>true</GenerateBindingRedirectsOutputType>












Getting the bits

The recommended way to add EF Core runtime libraries into an application is to install an EF Core database provider from NuGet.

Besides the runtime libraries, you can install tools which make it easier to perform several EF Core-related tasks in your project at design time, such as creating and applying migrations, and creating a model based on an existing database.


[!TIP]If you need to update an application that is using a third-party database provider, always check for an update of the provider that is compatible with the version of EF Core you want to use. E.g. database providers for previous versions are not compatible with version 2.0 of the EF Core runtime.



[!TIP]Applications targeting ASP.NET Core 2.0 can use EF Core 2.0 without additional dependencies besides third party database providers. Applications targeting previous versions of ASP.NET Core need to upgrade to ASP.NET Core 2.0 in order to use EF Core 2.0.


[bookmark: cli]


Cross-platform development using the .NET Core Command Line Interface (CLI)

To develop applications that target .NET Core [https://www.microsoft.com/net/download/core] you can choose to use the dotnet CLI commands [https://docs.microsoft.com/dotnet/core/tools/] in combination with your favorite text editor, or an Integrated Development Environment (IDE) such as Visual Studio, Visual Studio for Mac or Visual Studio Code.


[!IMPORTANT]Applications that target .NET Core require specific versions of Visual Studio, e.g. .NET Core 1.x development requires Visual Studio 2017, while .NET Core 2.0 development requires Visual Studio 2017 version 15.3.


To install or upgrade the SQL Server provider in a cross-platform .NET Core application, switch to the application’s directory and run the following in a command line:

dotnet add package Microsoft.EntityFrameworkCore.SqlServer





You can indicate a specific version install in the dotnet add package command, using the -v modifier. E.g. to install EF Core 2.0 packages, append -v 2.0.0 to the command.

EF Core includes a set of additional commands for the dotnet CLI, starting with dotnet ef. In order to use the dotnet ef CLI commands, your application’s .csproj file needs to contain the following entry:

<ItemGroup>
  <DotNetCliToolReference Include="Microsoft.EntityFrameworkCore.Tools.DotNet" Version="2.0.0" />
</ItemGroup>





The .NET Core CLI tools for EF Core also require a separate package called Microsoft.EntityFrameworkCore.Design. You can simply add it to the project using:

dotnet add package Microsoft.EntityFrameworkCore.Design






[!IMPORTANT]Always use versions of the tools packages that match the major version of the runtime packages.


[bookmark: visual-studio]




Visual Studio development

You can develop many different types of applications that target .NET Core, .NET Framework, or other platforms supported by EF Core using Visual Studio.

There are two ways you can install an EF Core database provider in your application from Visual Studio:


Using NuGet’s Package Manager User Interface [https://docs.microsoft.com/nuget/tools/package-manager-ui]


	Select on the menu Project > Manage NuGet Packages

	Click on the Browse or the Updates tab

	Select the Microsoft.EntityFrameworkCore.SqlServer package and the desired version and confirm






Using NuGet’s Package Manager Console (PMC) [https://docs.microsoft.com/nuget/tools/package-manager-console]


	Select on the menu Tools > NuGet Package Manager > Package Manager Console



	Type and run the following command in the PMC:

Install-Package Microsoft.EntityFrameworkCore.SqlServer







	You can use the Update-Package command instead to update a package that is already installed to a more recent  version



	To specify a specific version, you can use the -Version modifier, e.g. to install EF Core 2.0 packages, append -Version 2.0.0 to the commands








Tools

There is also a PowerShell version of the EF Core commands which run inside the PMC in Visual Studio, with similar capabilities to the dotnet ef commands. In order to use these, install the Microsoft.EntityFrameworkCore.Tools package using either the Package Manager UI or the PMC.


[!IMPORTANT]Always use versions of the tools packages that match the major version of the runtime packages.



[!TIP]Although it is possible to use the dotnet ef commands from the PMC in Visual Studio, it is far more convenient to use the PowerShell version:


	They automatically work with the current project selected in the PMC without requiring manually switching directories.

	They automatically open files generated by the commands in Visual Studio after the command is completed.







[!IMPORTANT]Deprecated packages in EF Core 2.0: If you are upgrading an existing application to EF Core 2.0, some references to older EF Core packages may need to be removed manually. In particular, database provider design-time packages such as Microsoft.EntityFrameworkCore.SqlServer.Design are no longer required or supported in EF Core 2.0, but will not be automatically removed when upgrading the other packages.
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Getting Started with EF Core on Universal Windows Platform (UWP)

These 101 tutorials require no previous knowledge of Entity Framework Core or Visual Studio. They will take you step-by-step through creating a simple Universal Window Platform (UWP) application that queries and saves data from a database.

You can find the UWP documentation at developer.microsoft.com/windows/apps/develop [https://developer.microsoft.com/windows/apps/develop].


[!NOTE]These tutorials and the accompanying samples have been updated to use EF Core 2.0 (with the exception of the UWP tutorial, that still uses EF Core 1.1). However, in the majority of cases it should be possible to create applications that use previous releases, with minimal modification to the instructions.
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Getting Started with EF Core on Universal Windows Platform (UWP) with a New Database


[!NOTE]Temporarily this tutorial uses EF Core 1.1. UWP has not been updated yet to support .NET Standard 2.0 which is required for compatibility with EF Core 2.0. Once it is, we will update the tutorial to use the new version.


In this walkthrough, you will build a Universal Windows Platform (UWP) application that performs basic data access against a local SQLite database using Entity Framework.


[!WARNING]Avoid using anonymous types in LINQ queries on UWP. Deploying a UWP application to the app store requires your application to be compiled with .NET Native. Queries with anonymous types have poor performance on .NET Native or may crash the application.



[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/GetStarted/UWP/UWP.SQLite] on GitHub.



Prerequisites

The following items are required to complete this walkthrough:


	Windows 10

	Visual Studio 2017 [https://www.visualstudio.com/downloads/]

	The latest version of Windows 10 Developer Tools [https://dev.windows.com/downloads]






Create a new project


	Open Visual Studio

	File > New > Project...

	From the left menu select Templates > Visual C# > Windows Universal

	Select the Blank App (Universal Windows) project template

	Give the project a name and click OK






Upgrade Microsoft.NETCore.UniversalWindowsPlatform

Depending on your version of Visual Studio, the template may have generated your project with an old version of .NET Core for UWP. EF Core requires Microsoft.NETCore.UniversalWindowsPlatform version 5.2.2 or greater.


	Tools > NuGet Package Manager > Package Manager Console

	Run Update-Package Microsoft.NETCore.UniversalWindowsPlatform –Version 5.2.2




[!TIP]If you are using Visual Studio 2017, you can upgrade to the latest version of Microsoft.NETCore.UniversalWindowsPlatform and do not need to explicitly target 5.2.2.





Install Entity Framework

To use EF Core, install the package for the database provider(s) you want to target. This walkthrough uses SQLite. For a list of available providers see Database Providers.


	Tools > NuGet Package Manager > Package Manager Console

	Run Install-Package Microsoft.EntityFrameworkCore.Sqlite



Later in this walkthrough we will also be using some Entity Framework Tools to maintain the database. So we will install the tools package as well.


	Run Install-Package Microsoft.EntityFrameworkCore.Tools






Create your model

Now it’s time to define a context and entity classes that make up your model.


	Project > Add Class...

	Enter Model.cs as the name and click OK

	Replace the contents of the file with the following code




``` csharp
using Microsoft.EntityFrameworkCore;
using System.Collections.Generic;namespace EFGetStarted.UWP
{
public class BloggingContext : DbContext
{
public DbSet Blogs { get; set; }
public DbSet Posts { get; set; }
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Querying Data

Entity Framework Core uses Language Integrate Query (LINQ) to query data from the database. LINQ allows you to use C# (or your .NET language of choice) to write strongly typed queries based on your derived context and entity classes. A representation of the LINQ query is passed to the database provider, to be translated in database-specific query language (e.g. SQL for a relational database). For more detailed information on how a query is processed, see How Query Works.
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Raw SQL Queries

Entity Framework Core allows you to drop down to raw SQL queries when working with a relational database. This can be useful if the query you want to perform can’t be expressed using LINQ, or if using a LINQ query is resulting in inefficient SQL being sent to the database.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Querying] on GitHub.



Limitations

There are a couple of limitations to be aware of when using raw SQL queries:


	SQL queries can only be used to return entity types that are part of your model. There is an enhancement on our backlog to enable returning ad-hoc types from raw SQL queries [https://github.com/aspnet/EntityFramework/issues/1862].

	The SQL query must return data for all properties of the entity type.

	The column names in the result set must match the column names that properties are mapped to. Note this is different from EF6 where property/column mapping was ignored for raw SQL queries and result set column names had to match the property names.

	The SQL query cannot contain related data. However, in many cases you can compose on top of the query using the Include operator to return related data (see Including related data).






Basic raw SQL queries

You can use the FromSql extension method to begin a LINQ query based on a raw SQL query.


``` csharp
var blogs = context.Blogs
    .FromSql("SELECT * FROM dbo.Blogs")
    .ToList();
```Raw SQL queries can be used to execute a stored procedure.


``` csharp
var blogs = context.Blogs
    .FromSql("EXECUTE dbo.GetMostPopularBlogs")
    .ToList();
```


Passing parameters

As with any API that accepts SQL, it is important to parameterize any user input to protect against a SQL injection attack. You can include parameter placeholders in the SQL query string and then supply parameter values as additional arguments. Any parameter values you supply will automatically be converted to a DbParameter.

The following example passes a single parameter to a stored procedure. While this may look like String.Format syntax, the supplied value is wrapped in a parameter and the generated parameter name inserted where the {0} placeholder was specified.


``` csharp
var user = "johndoe";var blogs = context.Blogs
.FromSql(“EXECUTE dbo.GetMostPopularBlogsForUser {0}”, user)
.ToList();


This is the same query but using string interpolation syntax, which is supported in EF Core 2.0 and above:

<!-- [!code-csharp[Main](samples/core/Querying/Querying/RawSQL/Sample.cs)] -->
``` csharp
var user = "johndoe";

var blogs = context.Blogs
    .FromSql($"EXECUTE dbo.GetMostPopularBlogsForUser {user}")
    .ToList();





You can also construct a DbParameter and supply it as a parameter value. This allows you to use named parameters in the SQL query string


``` csharp
var user = new SqlParameter("user", "johndoe");var blogs = context.Blogs
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Client vs. Server Evaluation

Entity Framework Core supports parts of the query being evaluated on the client and parts of it being pushed to the database. It is up to the database provider to determine which parts of the query will be evaluated in the database.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Querying] on GitHub.



Client evaluation

In the following example a helper method is used to standardize URLs for blogs that are returned from a SQL Server database. Because the SQL Server provider has no insight into how this method is implemented, it is not possible to translate it into SQL. All other aspects of the query are evaluated in the database, but passing the returned URL through this method is performed on the client.


``` csharp
var blogs = context.Blogs
    .OrderByDescending(blog => blog.Rating)
    .Select(blog => new
    {
        Id = blog.BlogId,
        Url = StandardizeUrl(blog.Url)
    })
    .ToList();
```
``` csharp
public static string StandardizeUrl(string url)
{
    url = url.ToLower();if (!url.StartsWith("http://"))
{
    url = string.Concat("http://", url);
}

return url;





}


## Disabling client evaluation

While client evaluation can be very useful, in some instances it can result in poor performance. Consider the following query, where the helper method is now used in a filter. Because this can't be performed in the database, all the data is pulled into memory and then the filter is applied on the client. Depending on the amount of data, and how much of that data is filtered out, this could result in poor performance.

<!-- [!code-csharp[Main](samples/core/Querying/Querying/ClientEval/Sample.cs)] -->
``` csharp
var blogs = context.Blogs
    .Where(blog => StandardizeUrl(blog.Url).Contains("dotnet"))
    .ToList();





By default, EF Core will log a warning when client evaluation is performed. See Logging for more information on viewing logging output. You can change the behavior when client evaluation occurs to either throw or do nothing. This is done when setting up the options for your context - typically in DbContext.OnConfiguring, or in Startup.cs if you are using ASP.NET Core.


``` csharp
protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
{
    optionsBuilder
        .UseSqlServer(@"Server=(localdb)\mssqllocaldb;Database=EFQuerying;Trusted_Connection=True;")
        .ConfigureWarnings(warnings => warnings.Throw(RelationalEventId.QueryClientEvaluationWarning));
}
```
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Basic Queries

Learn how to load entities from the database using Language Integrate Query (LINQ).


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Querying] on GitHub.



101 LINQ samples

This page shows a few examples to achieve common tasks with Entity Framework Core. For an extensive set of samples showing what is possible with LINQ, see 101 LINQ Samples [https://code.msdn.microsoft.com/101-LINQ-Samples-3fb9811b].




Loading all data


``` csharp
using (var context = new BloggingContext())
{
    var blogs = context.Blogs.ToList();
}
```


Loading a single entity


``` csharp
using (var context = new BloggingContext())
{
    var blog = context.Blogs
        .Single(b => b.BlogId == 1);
}
```


Filtering


``` csharp
using (var context = new BloggingContext())
{
    var blogs = context.Blogs
        .Where(b => b.Url.Contains("dotnet"))
        .ToList();
}
```
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Loading Related Data

Entity Framework Core allows you to use the navigation properties in your model to load related entities. There are three common O/RM patterns used to load related data.


	Eager loading means that the related data is loaded from the database as part of the initial query.

	Explicit loading means that the related data is explicitly loaded from the database at a later time.

	Lazy loading means that the related data is transparently loaded from the database when the navigation property is accessed. Lazy loading is not yet possible with EF Core.




[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Querying] on GitHub.



Eager loading

You can use the Include method to specify related data to be included in query results. In the following example, the blogs that are returned in the results will have their Posts property populated with the related posts.

[!code-csharpMain]


[!TIP]Entity Framework Core will automatically fix-up navigation properties to any other entities that were previously loaded into the context instance. So even if you don’t explicitly include the data for a navigation property, the property may still be populated if some or all of the related entities were previously loaded.


You can include related data from multiple relationships in a single query.

[!code-csharpMain]


Including multiple levels

You can drill down thru relationships to include multiple levels of related data using the ThenInclude method. The following example loads all blogs, their related posts, and the author of each post.

[!code-csharpMain]

You can chain multiple calls to ThenInclude to continue including further levels of related data.

[!code-csharpMain]

You can combine all of this to include related data from multiple levels and multiple roots in the same query.

[!code-csharpMain]

You may want to include multiple related entities for one of the entities that is being included. For example, when querying Blogs, you include Posts and then want to include both the Author and Tags of the Posts. To do this, you need to specify each include path starting at the root. For example, Blog -> Posts -> Author and Blog -> Posts -> Tags. This does not mean you will get redundant joins, in most cases EF will consolidate the joins when generating SQL.

[!code-csharpMain]




Ignored includes

If you change the query so that it no longer returns instances of the entity type that the query began with, then the include operators are ignored.

In the following example, the include operators are based on the Blog, but then the Select operator is used to change the query to return an anonymous type. In this case, the include operators have no effect.

[!code-csharpMain]

By default, EF Core will log a warning when include operators are ignored. See Logging for more information on viewing logging output. You can change the behavior when an include operator is ignored to either throw or do nothing. This is done when setting up the options for your context - typically in DbContext.OnConfiguring, or in Startup.cs if you are using ASP.NET Core.

[!code-csharpMain]






Explicit loading


[!NOTE]This feature was introduced in EF Core 1.1.


You can explicitly load a navigation property via the DbContext.Entry(...) API.

[!code-csharpMain]

You can also explicitly load a navigation property by executing a seperate query that returns the related entities. If change tracking is enabled, then when loading an entity, EF Core will automatically set the navigation properties of the newly-loaded entitiy to refer to any entities already loaded, and set the navigation properties of the already-loaded entities to refer to the newly-loaded entity.


Querying related entities

You can also get a LINQ query that represents the contents of a navigation property.

This allows you to do things such as running an aggregate operator over the related entities without loading them into memory.

[!code-csharpMain]

You can also filter which related entities are loaded into memory.

[!code-csharpMain]






Lazy loading

Lazy loading is not yet supported by EF Core. You can view the lazy loading item on our backlog [https://github.com/aspnet/EntityFramework/issues/3797] to track this feature.




Related data and serialization

Because EF Core will automatically fix-up navigation properties, you can end up with cycles in your object graph. For example, Loading a blog and it’s related posts will result in a blog object that references a collection of posts. Each of those posts will have a reference back to the blog.

Some serialization frameworks do not allow such cycles. For example, Json.NET will throw the following exception if a cycle is encoutered.


Newtonsoft.Json.JsonSerializationException: Self referencing loop detected for property ‘Blog’ with type ‘MyApplication.Models.Blog’.


If you are using ASP.NET Core, you can configure Json.NET to ignore cycles that it finds in the object graph. This is done in the ConfigureServices(...) method in Startup.cs.

public void ConfigureServices(IServiceCollection services)
{
    ...

    services.AddMvc()
        .AddJsonOptions(
            options => options.SerializerSettings.ReferenceLoopHandling = Newtonsoft.Json.ReferenceLoopHandling.Ignore
        );

    ...
}
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Tracking vs. No-Tracking Queries

Tracking behavior controls whether or not Entity Framework Core will keep information about an entity instance in its change tracker. If an entity is tracked, any changes detected in the entity will be persisted to the database during SaveChanges(). Entity Framework Core will also fix-up navigation properties between entities that are obtained from a tracking query and entities that were previously loaded into the DbContext instance.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Querying] on GitHub.



Tracking queries

By default, queries that return entity types are tracking. This means you can make changes to those entity instances and have those changes persisted by SaveChanges().

In the following example, the change to the blogs rating will be detected and persisted to the database during SaveChanges().


``` csharp
using (var context = new BloggingContext())
{
    var blog = context.Blogs.SingleOrDefault(b => b.BlogId == 1);
    blog.Rating = 5;
    context.SaveChanges();
}
```


No-tracking queries

No tracking queries are useful when the results are used in a read-only scenario. They are quicker to execute because there is no need to setup change tracking information.

You can swap an individual query to be no-tracking:


``` csharp
using (var context = new BloggingContext())
{
    var blogs = context.Blogs
        .AsNoTracking()
        .ToList();
}
```You can also change the default tracking behavior at the context instance level:


``` csharp
using (var context = new BloggingContext())
{
    context.ChangeTracker.QueryTrackingBehavior = QueryTrackingBehavior.NoTracking;var blogs = context.Blogs.ToList();





}


> [!NOTE]  
> No tracking queries still perform identity resolution. If the result set contains the same entity multiple times, the same instance of the entity class will be returned for each occurrence in the result set. However, weak references are used to keep track of entities that have already been returned. If a previous result with the same identity goes out of scope, and garbage collection runs, you may get a new entity instance. For more information, see [How Query Works](overview.md).

## Tracking and projections

Even if the result type of the query isn't an entity type, if the result contains entity types they will still be tracked by default. In the following query, which returns an anonymous type, the instances of `Blog` in the result set will be tracked.

<!-- [!code-csharp[Main](samples/core/Querying/Querying/Tracking/Sample.cs?highlight=7)] -->
``` csharp
using (var context = new BloggingContext())
{
    var blog = context.Blogs
        .Select(b =>
            new
            {
                Blog = b,
                Posts = b.Posts.Count()
            });
}





If the result set does not contain any entity types, then no tracking is performed. In the following query, which returns an anonymous type with some of the values from the entity (but no instances of the actual entity type), there is no tracking performed.


``` csharp
using (var context = new BloggingContext())
{
    var blog = context.Blogs
        .Select(b =>
            new
            {
                Id = b.BlogId,
                Url = b.Url
            });
}
```
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Asynchronous Queries

Asynchronous queries avoid blocking a thread while the query is executed in the database. This can be useful to avoid freezing the UI of a thick-client application. Asynchronous operations can also increase throughput in a web application, where the thread can be freed up to service other requests while the database operation completes. For more information, see Asynchronous Programming in C# [https://docs.microsoft.com/dotnet/csharp/async].


[!WARNING]EF Core does not support multiple parallel operations being run on the same context instance. You should always wait for an operation to complete before beginning the next operation. This is typically done by using the await keyword on each asynchronous operation.


Entity Framework Core provides a set of asynchronous extension methods that can be used as an alternative to the LINQ methods that cause a query to be executed and results returned. Examples include ToListAsync(), ToArrayAsync(), SingleAsync(), etc. There are not async versions of LINQ operators such as Where(...), OrderBy(...), etc. because these methods only build up the LINQ expression tree and do not cause the query to be executed in the database.


[!IMPORTANT]The EF Core async extension methods are defined in the Microsoft.EntityFrameworkCore namespace. This namespace must be imported for the methods to be available.


[!code-csharpMain]
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How Queries Work

Entity Framework Core uses Language Integrate Query (LINQ) to query data from the database. LINQ allows you to use C# (or your .NET language of choice) to write strongly typed queries based on your derived context and entity classes.


The life of a query

The following is a high level overview of the process each query goes through.


	The LINQ query is processed by Entity Framework Core to build a representation that is ready to be processed by the database provider
	The result is cached so that this processing does not need to be done every time the query is executed





	The result is passed to the database provider
	The database provider identifies which parts of the query can be evaluated in the database

	These parts of the query are translated to database specific query language (e.g. SQL for a relational database)

	One or more queries are sent to the database and the result set returned (results are values from the database, not entity instances)





	For each item in the result set
	If this is a tracking query, EF checks if the data represents an entity already in the change tracker for the context instance
	If so, the existing entity is returned

	If not, a new entity is created, change tracking is setup, and the new entity is returned





	If this is a no-tracking query, EF checks if the data represents an entity already in the result set for this query
	If so, the existing entity is returned (1)

	If not, a new entity is created and returned











(1) No tracking queries use weak references to keep track of entities that have already been returned. If a previous result with the same identity goes out of scope, and garbage collection runs, you may get a new entity instance.




When queries are executed

When you call LINQ operators, you are simply building up an in-memory representation of the query. The query is only sent to the database when the results are consumed.

The most common operations that result in the query being sent to the database are:


	Iterating the results in a for loop

	Using an operator such as ToList, ToArray, Single, Count

	Databinding the results of a query to a UI




[!WARNING]Always validate user input: While EF does provide protection from SQL injection attacks, it does not do any general validation of input. Therefore if values being passed to APIs, used in LINQ queries, assigned to entity properties, etc., come from an untrusted source then appropriate validation, per your application requirements, should be performed. This includes any user input used to dynamically construct queries. Even when using LINQ, if you are accepting user input to build expressions you need to make sure than only intended expressions can be constructed.
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Upgrading from EF Core 1.0 RC2 to RTM

This article provides guidance for moving an application built with the RC2 packages to 1.0.0 RTM.


Package Versions

The names of the top level packages that you would typically install into an application did not change between RC2 and RTM.

You need to upgrade the installed packages to the RTM versions:


	Runtime packages (e.g. Microsoft.EntityFrameworkCore.SqlServer) changed from 1.0.0-rc2-final to 1.0.0.

	The Microsoft.EntityFrameworkCore.Tools package changed from 1.0.0-preview1-final to 1.0.0-preview2-final. Note that tooling is still pre-release.






Existing migrations may need maxLength added

In RC2, the column definition in a migration looked like table.Column<string>(nullable: true) and the length of the column was looked up in some metadata we store in the code behind the migration. In RTM, the length is now included in the scaffolded code table.Column<string>(maxLength: 450, nullable: true).

Any existing migrations that were scaffolded prior to using RTM will not have the maxLength argument specified. This means the maximum length supported by the database will be used (nvarchar(max) on SQL Server). This may be fine for some columns, but columns that are part of a key, foreign key, or index need to be updated to include a maximum length. By convention, 450 is the maximum length used for keys, foreign keys, and indexed columns. If you have explicitly configured a length in the model, then you should use that length instead.

ASP.NET Identity

This change impacts projects that use ASP.NET Identity and were created from a pre-RTM project template. The project template includes a migration used to create the database. This migration must be edited to specify a maximum length of 256 for the following columns.


	AspNetRoles
	Name

	NormalizedName





	AspNetUsers
	Email

	NormalizedEmail

	NormalizedUserName

	UserName







Failure to make this change will result in the following exception when the initial migration is applied to a database.

System.Data.SqlClient.SqlException (0x80131904): Column 'NormalizedName' in table 'AspNetRoles' is of a type that is invalid for use as a key column in an index.








.NET Core: Remove “imports” in project.json

If you were targeting .NET Core with RC2, you needed to add imports to project.json as a temporary workaround for some of EF Core’s dependencies not supporting .NET Standard. These can now be removed.

{
  "frameworks": {
    "netcoreapp1.0": {
      "imports": ["dnxcore50", "portable-net451+win8"]
    }
  }
}








UWP: Add binding redirects

Attempting to run EF commands on Universal Windows Platform (UWP) projects results in the following error:

System.IO.FileLoadException: Could not load file or assembly 'System.IO.FileSystem.Primitives, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a' or one of its dependencies. The located assembly's manifest definition does not match the assembly reference.





You need to manually add binding redirects to the UWP project. Create a file named App.config in the project root folder and add redirects to the correct assembly versions.

<configuration>
 <runtime>
   <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
     <dependentAssembly>
       <assemblyIdentity name="System.IO.FileSystem.Primitives"
                         publicKeyToken="b03f5f7f11d50a3a"
                         culture="neutral" />
       <bindingRedirect oldVersion="4.0.0.0"
                        newVersion="4.0.1.0"/>
     </dependentAssembly>
     <dependentAssembly>
       <assemblyIdentity name="System.Threading.Overlapped"
                         publicKeyToken="b03f5f7f11d50a3a"
                         culture="neutral" />
       <bindingRedirect oldVersion="4.0.0.0"
                        newVersion="4.0.1.0"/>
     </dependentAssembly>
   </assemblyBinding>
 </runtime>
</configuration>
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Logging


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Miscellaneous/Logging] on GitHub.



ASP.NET Core applications

EF Core integrates automatically with the logging mechanims of ASP.NET Core whenever AddDbContext or AddDbContextPool is used. Therefore, when using ASP.NET Core, logging should be configured as described in the ASP.NET Core documentation [https://docs.microsoft.com/en-us/aspnet/core/fundamentals/logging?tabs=aspnetcore2x].




Other applications

EF Core logging currently requires an ILoggerFactory which is itself configured with one or more ILoggerProvider. Common providers are shipped in the following packages:


	Microsoft.Extensions.Logging.Console [https://www.nuget.org/packages/Microsoft.Extensions.Logging.Console/]: A simple console logger.

	Microsoft.Extensions.Logging.AzureAppServices [https://www.nuget.org/packages/Microsoft.Extensions.Logging.AzureAppServices/]: Supports Azure App Services ‘Diagnostics logs’ and ‘Log stream’ features.

	Microsoft.Extensions.Logging.Debug [https://www.nuget.org/packages/Microsoft.Extensions.Logging.Debug/]: Logs to a debugger monitor using System.Diagnostics.Debug.WriteLine().

	Microsoft.Extensions.Logging.EventLog [https://www.nuget.org/packages/Microsoft.Extensions.Logging.EventLog/]: Logs to Windows Event Log.

	Microsoft.Extensions.Logging.EventSource [https://www.nuget.org/packages/Microsoft.Extensions.Logging.EventSource/]: Supports EventSource/EventListener.

	Microsoft.Extensions.Logging.TraceSource [https://www.nuget.org/packages/Microsoft.Extensions.Logging.TraceSource/]: Logs to a trace listener using System.Diagnostics.TraceSource.TraceEvent().



After installing the appropriate package(s), the application should create a singleton/global instance of a LoggerFactory. For example, using the console logger:

[!code-csharpMain]

This singleton/global instance should then be registered with EF Core on the DbContextOptionsBuilder. For example:

[!code-csharpMain]


[!WARNING]
It is very important that applications do not create a new ILoggerFactory instance for each context instance. Doing so will result in a memory leak and poor performance.





Filtering what is logged

The easiest way to filter what is logged is to configure it when registering the ILoggerProvider. For example:

[!code-csharpMain]

In this example, the log is filtered to return only messages:


	in the ‘Microsoft.EntityFrameworkCore.Database.Command’ category

	at the ‘Information’ level



For EF Core, logger categories are defined in the DbLoggerCategory class to make it easy to find categories, but these resolve to simple strings.

More details on the underlying logging infrastructure can be found in the ASP.NET Core logging documentation [https://docs.microsoft.com/en-us/aspnet/core/fundamentals/logging?tabs=aspnetcore2x].
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Configuring a DbContext

This article shows patterns for configuring a DbContext with DbContextOptions. Options are primarily used to select and configure the data store.


Configuring DbContextOptions

DbContext must have an instance of DbContextOptions in order to execute. This can be configured by overriding OnConfiguring, or supplied externally via a constructor argument.

If both are used, OnConfiguring is executed on the supplied options, meaning it is additive and can overwrite  options supplied to the constructor argument.


Constructor argument

Context code with constructor

public class BloggingContext : DbContext
{
    public BloggingContext(DbContextOptions<BloggingContext> options)
        : base(options)
    { }

    public DbSet<Blog> Blogs { get; set; }
}






[!TIP]The base constructor of DbContext also accepts the non-generic version of DbContextOptions. Using the non-generic version is not recommended for applications with multiple context types.


Application code to initialize from constructor argument

var optionsBuilder = new DbContextOptionsBuilder<BloggingContext>();
optionsBuilder.UseSqlite("Data Source=blog.db");

using (var context = new BloggingContext(optionsBuilder.Options))
{
  // do stuff
}








OnConfiguring


[!WARNING]OnConfiguring occurs last and can overwrite options obtained from DI or the constructor. This approach does not lend itself to testing (unless you target the full database).


Context code with OnConfiguring:

public class BloggingContext : DbContext
{
    public DbSet<Blog> Blogs { get; set; }

    protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
    {
        optionsBuilder.UseSqlite("Data Source=blog.db");
    }
}





Application code to initialize with OnConfiguring:

using (var context = new BloggingContext())
{
  // do stuff
}










Using DbContext with dependency injection

EF supports using DbContext with a dependency injection container. Your DbContext type can be added to the service container by using AddDbContext<TContext>.

AddDbContext will make both your DbContext type, TContext, and DbContextOptions<TContext> available for injection from the service container.

See more reading below for information on dependency injection.

Adding dbcontext to dependency injection

public void ConfigureServices(IServiceCollection services)
{
    services.AddDbContext<BloggingContext>(options => options.UseSqlite("Data Source=blog.db"));
}





This requires adding a constructor argument to your DbContext type that accepts DbContextOptions.

Context code:

public class BloggingContext : DbContext
{
    public BloggingContext(DbContextOptions<BloggingContext> options)
      :base(options)
    { }

    public DbSet<Blog> Blogs { get; set; }
}





Application code (in ASP.NET Core):

public MyController(BloggingContext context)





Application code (using ServiceProvider directly, less common):

using (var context = serviceProvider.GetService<BloggingContext>())
{
  // do stuff
}

var options = serviceProvider.GetService<DbContextOptions<BloggingContext>>();








Using IDesignTimeDbContextFactory<TContext>

As an alternative to the options above, you may also provide an implementation of IDesignTimeDbContextFactory<TContext>. EF tools can use this factory to create an instance of your DbContext. This may be required in order to enable specific design-time experiences such as migrations.

Implement this interface to enable design-time services for context types that do not have a public default constructor. Design-time services will automatically discover implementations of this interface that are in the same assembly as the derived context.

Example:

using Microsoft.EntityFrameworkCore;
using Microsoft.EntityFrameworkCore.Infrastructure;

namespace MyProject
{
    public class BloggingContextFactory : IDesignTimeDbContextFactory<BloggingContext>
    {
        public BloggingContext CreateDbContext(string[] args)
        {
            var optionsBuilder = new DbContextOptionsBuilder<BloggingContext>();
            optionsBuilder.UseSqlite("Data Source=blog.db");

            return new BloggingContext(optionsBuilder.Options);
        }
    }
}








More reading


	Read Getting Started on ASP.NET Core for more information on using EF with ASP.NET Core.

	Read Dependency Injection [https://docs.asp.net/en/latest/fundamentals/dependency-injection.html] to learn more about using DI.

	Read Testing for more information.
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Upgrading from EF Core 1.0 RC1 to 1.0 RC2

This article provides guidance for moving an application built with the RC1 packages to RC2.


Package Names and Versions

Between RC1 and RC2, we changed from “Entity Framework 7” to “Entity Framework Core”. You can read more about the reasons for the change in this post by Scott Hanselman [http://www.hanselman.com/blog/ASPNET5IsDeadIntroducingASPNETCore10AndNETCore10.aspx]. Because of this change, our package names changed from EntityFramework.* to Microsoft.EntityFrameworkCore.* and our versions from 7.0.0-rc1-final to 1.0.0-rc2-final (or 1.0.0-preview1-final for tooling).

You will need to completely remove the RC1 packages and then install the RC2 ones. Here is the mapping for some common packages.

| RC1 Package                                               | RC2 Equivalent                                                       |
| ——————————————————— | ——————————————————————– |
| EntityFramework.MicrosoftSqlServer        7.0.0-rc1-final | Microsoft.EntityFrameworkCore.SqlServer         1.0.0-rc2-final      |
| EntityFramework.SQLite                    7.0.0-rc1-final | Microsoft.EntityFrameworkCore.SQLite            1.0.0-rc2-final      |
| EntityFramework7.Npgsql                   3.1.0-rc1-3     | NpgSql.EntityFrameworkCore.Postgres             
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Connection Strings

Most database providers require some form of connection string to connect to the database. Sometimes this connection string contains sensitive information that needs to be protected. You may also need to change the connection string as you move your application between environments, such as development, testing, and production.


.NET Framework Applications

.NET Framework applications, such as WinForms, WPF, Console, and ASP.NET 4, have a tried and tested connection string pattern. The connection string should be added to your applications App.config file (Web.config if you are using ASP.NET). If your connection string contains sensitive information, such as username and password, you can protect the contents of the configuration file using Protected Configuration [https://docs.microsoft.com/dotnet/framework/data/adonet/connection-strings-and-configuration-files#encrypting-configuration-file-sections-using-protected-configuration].

<?xml version="1.0" encoding="utf-8"?>
<configuration>

  <connectionStrings>
    <add name="BloggingDatabase"
         connectionString="Server=(localdb)\mssqllocaldb;Database=Blogging;Trusted_Connection=True;" />
  </connectionStrings>
</configuration>






[!TIP]The providerName setting is not required on EF Core connection strings stored in App.config because the database provider is configured via code.


You can then read the connection string using the ConfigurationManager API in your context’s OnConfiguring method. You may need to add a reference to the System.Configuration framework assembly to be able to use this API.

public class BloggingContext : DbContext
{
    public DbSet<Blog> Blogs { get; set; }
    public DbSet<Post> Posts { get; set; }

    protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
    {
      optionsBuilder.UseSqlServer(ConfigurationManager.ConnectionStrings["BloggingDatabase"].ConnectionString);
    }
}








Universal Windows Platform (UWP)

Connection strings in a UWP application are typically a SQLite connection that just specifies a local filename. They typically do not contain sensitive information, and do not need to be changed as an application is deployed. As such, these connection strings are usually fine to be left in code, as shown below. If you wish to move them out of code then UWP supports the concept of settings, see the App Settings section of the UWP documentation [https://docs.microsoft.com/windows/uwp/app-settings/store-and-retrieve-app-data] for details.

public class BloggingContext : DbContext
{
    public DbSet<Blog> Blogs { get; set; }
    public DbSet<Post> Posts { get; set; }

    protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
    {
            optionsBuilder.UseSqlite("Data Source=blogging.db");
    }
}








ASP.NET Core

In ASP.NET Core the configuration system is very flexible, and the connection string could be stored in appsettings.json, an environment variable, the user secret store, or another configuration source. See the Configuration section of the ASP.NET Core documentation [https://docs.asp.net/en/latest/fundamentals/configuration.html] for more details. The following example shows the connection string stored in appsettings.json.

{
  "ConnectionStrings": {
    "BloggingDatabase": "Server=(localdb)\\mssqllocaldb;Database=EFGetStarted.ConsoleApp.NewDb;Trusted_Connection=True;"
  },
}





The context is typically configured in Startup.cs with the connection string being read from configuration. Note the GetConnectionString() method looks for a configuration value whose key is ConnectionStrings:<connection string name>.

public void ConfigureServices(IServiceCollection services)
{
    services.AddDbContext<BloggingContext>(options =>
        options.UseSqlServer(Configuration.GetConnectionString("BloggingDatabase")));
}
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Upgrading applications from previous versions to EF Core 2.0


Procedures Common to All Applications

Updating an existing application to EF Core 2.0 may require:


	Upgrading the target .NET platform of the application to one that supports .NET Standard 2.0. See Supported Platforms for more details.

	Identify a provider for the target database which is compatible with EF Core 2.0. See EF Core 2.0 requires a 2.0 database provider below.

	Upgrading all the EF Core packages (runtime and tooling) to 2.0. Refer to Installing EF Core for more details.

	Make any necessary code changes to compensate for breaking changes. See the Breaking Changes section below for more details.






ASP.NET Core applications


	See in particular the new pattern for initializing the application’s service provider described below.




[!TIP]The adoption of this new pattern when updating applications to 2.0 is highly recommended and is required in order for product features like Entity Framework Core Migrations to work. The other common alternative is to implement IDesignTimeDbContextFactory<TContext>.



	Applications targeting ASP.NET Core 2.0 can use EF Core 2.0 without additional dependencies besides third party database providers. However, applications targeting previous versions of ASP.NET Core need to upgrade to ASP.NET Core 2.0 in order to use EF Core 2.0. For more details on upgrading ASP.NET Core applications to 2.0 see the ASP.NET Core documentation on the subject [https://docs.microsoft.com/aspnet/core/migration/1x-to-2x/].






Breaking Changes

We have taken the opportunity to significantly refine our existing APIs and behaviors in 2.0. There are a few improvements that can require modifying existing application code, although we believe that for the majority of applications the impact will be low, in most cases requiring just recompilation and minimal guided changes to replace obsolete APIs.


New way of getting application services

The recommended pattern for ASP.NET Core web applications has been updated for 2.0 in a way that broke the design-time logic EF Core used in 1.x. Previously at design-time, EF Core would try to invoke Startup.ConfigureServices directly in order to access the application’s service provider. In ASP.NET Core 2.0, Configuration is initialized outside of the Startup class. Applications using EF Core typically access their connection string from Configuration, so Startup by itself is no longer sufficient. If you upgrade an ASP.NET Core 1.x application, you may receive the following error when using the EF Core tools.


No parameterless constructor was found on ‘ApplicationContext’. Either add a parameterless constructor to ‘ApplicationContext’ or add an implementation of ‘IDesignTimeDbContextFactory&lt;

ApplicationContext&gt;

‘ in the same assembly as ‘ApplicationContext’


A new design-time hook has been added in ASP.NET Core 2.0’s default template. The static Program.BuildWebHost method enables EF Core to access the application’s service provider at design time. If you are upgrading an ASP.NET Core 1.x application, you will need to update you Program class to resemble the following.

using Microsoft.AspNetCore;
using Microsoft.AspNetCore.Hosting;

namespace AspNetCoreDotNetCore2._0App
{
    public class Program
    {
        public static void Main(string[] args)
        {
            BuildWebHost(args).Run();
        }

        public static IWebHost BuildWebHost(string[] args) =>
            WebHost.CreateDefaultBuilder(args)
                .UseStartup<Startup>()
                .Build();
    }
}








IDbContextFactory renamed

In order to support diverse application patterns and give users more control over how their DbContext is used at design time, we have, in the past, provided the IDbContextFactory<TContext> interface. At design-time, the EF Core tools will discover implementations of this interface in your project and use it to create DbContext objects.

This interface had a very general name which mislead some users to try re-using it for other DbContext-creating scenarios. They were caught off guard when the EF Tools then tried to use their implementation at design-time and caused commands like Update-Database or dotnet ef database update to fail.

In order to communicate the strong design-time semantics of this interface, we have renamed it to IDesignTimeDbContextFactory<TContext>.

For the 2.0 release the IDbContextFactory<TContext> still exists but is marked as obsolete.




DbContextFactoryOptions removed

Because of the ASP.NET Core 2.0 changes described above, we found that DbContextFactoryOptions was no longer needed on the new IDesignTimeDbContextFactory<TContext> interface. Here are the alternatives you should be using instead.

DbContextFactoryOptions | Alternative
— | —
ApplicationBasePath | AppContext.BaseDirectory
ContentRootPath | Directory.GetCurrentDirectory()
EnvironmentName | Environment.GetEnvironmentVariable(“ASPNETCORE_ENVIRONMENT”)




Design-time working directory changed

The ASP.NET Core 2.0 changes also required the working directory used by dotnet ef to align with the working directory used by Visual Studio when running your application. One observable side effect of this is that SQLite filenames are now relative to the project directory and not the output directory like they used to be.




EF Core 2.0 requires a 2.0 database provider

For EF Core 2.0 we have made many simplifications and improvements in the way database providers work. This means that 1.0.x and 1.1.x providers will not work with EF Core 2.0.

The SQL Server and SQLite providers are shipped by the EF team and 2.0 versions will be available as part of the 2.0 release. The open-source third party providers for SQL Compact [https://github.com/ErikEJ/EntityFramework.SqlServerCompact], PostgreSQL [https://github.com/npgsql/Npgsql.EntityFrameworkCore.PostgreSQL], and MySQL [https://github.com/PomeloFoundation/Pomelo.EntityFrameworkCore.MySql] are being updated for 2.0. For all other providers, please contact the provider writer.




Logging and Diagnostics events have changed

Note: these changes should not impact most application code.

The event IDs for messages sent to an ILogger [https://github.com/aspnet/Logging/blob/dev/src/Microsoft.Extensions.Logging.Abstractions/ILogger.cs] have changed in 2.0. The event IDs are now unique across EF Core code. These messages now also follow the standard pattern for structured logging used by, for example, MVC.

Logger categories have also changed. There is now a well-known set of categories accessed through DbLoggerCategory [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/DbLoggerCategory.cs].

DiagnosticSource [https://github.com/dotnet/corefx/blob/master/src/System.Diagnostics.DiagnosticSource/src/DiagnosticSourceUsersGuide.md] events now use the same event ID names as the corresponding ILogger messages. The event payloads are all nominal types derived from EventData [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Diagnostics/EventData.cs].

Event IDs, payload types, and categories are documented in the CoreEventId [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Diagnostics/CoreEventId.cs] and the RelationalEventId [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore.Relational/Diagnostics/RelationalEventId.cs] classes.

IDs have also moved from Microsoft.EntityFrameworkCore.Infraestructure to the new Microsoft.EntityFrameworkCore.Diagnostics namespace.




EF Core relational metadata API changes

EF Core 2.0 will now build a different IModel [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Metadata/IModel.cs] for each different provider being used. This is usually transparent to the application. This has facilitated a simplification of lower-level metadata APIs such that any access to common relational metadata concepts is always made through a call to .Relational instead of .SqlServer, .Sqlite, etc. For example, 1.1.x code like this:

var tableName = context.Model.FindEntityType(typeof(User)).SqlServer().TableName;





Should now be written like this:

var tableName = context.Model.FindEntityType(typeof(User)).Relational().TableName;





Instead of using methods like ForSqlServerToTable, extension methods are now available to write conditional code based on the current provider in use. For example:

modelBuilder.Entity<User>().ToTable(
    Database.IsSqlServer() ? "SqlServerName" : "OtherName");





Note that this change only applies to APIs/metadata that is defined for all relational providers. The API and metadata remains the same when it is specific to only a single provider. For example, clustered indexes are specific to SQL Sever, so ForSqlServerIsClustered and  .SqlServer().IsClustered() must still be used.




Don’t take control of the EF service provider

EF Core uses an internal IServiceProvider (i.e. a dependency injection container) for its internal implementation. Applications should allow EF Core to create and manage this provider except in special cases. Strongly consider removing any calls to UseInternalServiceProvider. If an application does need to call UseInternalServiceProvider, then please consider filing an issue [https://github.com/aspnet/EntityFramework/Issues] so we can investigate other ways to handle your scenario.

Calling AddEntityFramework, AddEntityFrameworkSqlServer, etc. is not required by application code unless UseInternalServiceProvider is also called. Remove any existing calls to AddEntityFramework or AddEntityFrameworkSqlServer, etc. AddDbContext should still be used in the same way as before.




In-memory databases must be named

The global unnamed in-memory database has been removed and instead all in-memory databases must be named. For example:

optionsBuilder.UseInMemoryDatabase("MyDatabase");





This creates/uses a database with the name “MyDatabase”. If UseInMemoryDatabase is called again with the same name, then the same in-memory database will be used, allowing it to be shared by multiple context instances.




Read-only API changes

IsReadOnlyBeforeSave, IsReadOnlyAferSave, and IsStoreGeneratedAlways have been obsoleted and replaced with BeforeSaveBehavior [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Metadata/IProperty.cs#L39] and AfterSaveBehavior [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Metadata/IProperty.cs#L55]. These behaviors apply to any property (not only store-generated properties) and determine how the value of the property should be used when inserting into a database row (BeforeSaveBehavior) or when updating an existing database row (AfterSaveBehavior).

Properties marked as ValueGenerated.OnAddOrUpdate [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Metadata/ValueGenerated.cs] (e.g. for computed columns) will by default ignore any value currently set on the property. This means that a store-generated value will always be obtained regardless of whether any value has been set or modified on the tracked entity. This can be changed by setting a different Before\AfterSaveBehavior.




New ClientSetNull delete behavior

In previous releases, DeleteBehavior.Restrict [https://github.com/aspnet/EntityFramework/blob/dev/src/EFCore/Metadata/DeleteBehavior.cs] had a behavior for entities tracked by the context that more closed matched SetNull semantics. In EF Core 2.0, a new ClientSetNull behavior has been introduced as the default for optional relationships. This behavior has SetNull semantics for tracked entities and Restrict behavior for databases created using EF Core. In our experience, these are the most expected/useful behaviors for tracked entities and the database. DeleteBehavior.Restrict is now honored for tracked entities when set for optional relationships.




Provider design-time packages removed

The Microsoft.EntityFrameworkCore.Relational.Design package has been removed. It’s contents were consolidated into Microsoft.EntityFrameworkCore.Relational and Microsoft.EntityFrameworkCore.Design.

This propagates into the provider design-time packages. Those packages (Microsoft.EntityFrameworkCore.Sqlite.Design, Microsoft.EntityFrameworkCore.SqlServer.Design, etc.) were removed and their contents consolidated into the main provider packages.

To enable Scaffold-DbContext or dotnet ef dbcontext scaffold in EF Core 2.0, you only need to reference the single provider package:

<PackageReference Include="Microsoft.EntityFrameworkCore.SqlServer"
    Version="2.0.0" />
<PackageReference Include="Microsoft.EntityFrameworkCore.Tools"
    Version="2.0.0"
    PrivateAssets="All" />
<DotNetCliToolReference Include="Microsoft.EntityFrameworkCore.Tools.DotNet"
    Version="2.0.0" />
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Connection Resiliency

Connection resiliency automatically retries failed database commands. The feature can be used with any database by supplying an “execution strategy”, which encapsulates the logic necessary to detect failures and retry commands. EF Core providers can supply execution strategies tailored to their specific database failure conditions and optimal retry policies.

As an example, the SQL Server provider includes an execution strategy that is specifically tailored to SQL Server (including SQL Azure). It is aware of the exception types that can be retried and has sensible defaults for maximum retries, delay between retries, etc.

An execution strategy is specified when configuring the options for your context. This is typically in the OnConfiguring method of your derived context, or in Startup.cs for an ASP.NET Core application.

[!code-csharpMain]


Custom execution strategy

There is a mechanism to register a custom execution strategy of your own if you wish to change any of the defaults.

protected override void OnConfiguring(DbContextOptionsBuilder optionsBuilder)
{
    optionsBuilder
        .UseMyProvider(
            "<connection string>",
            options => options.ExecutionStrategy(...));
}








Execution strategies and transactions

An execution strategy that automatically retries on failures needs to be able to play back each operation in an retry block that fails. When retries are enabled, each operation you perform via EF Core becomes its own retriable operation, i.e. each query and each call to SaveChanges() will be retried as a unit if a transient failure occurs.

However, if your code initiates a transaction using BeginTransaction() you are defining your own group of operations that need to be treated as a unit, i.e. everything inside the transaction would need to be played back shall a failure occur. You will receive an exception like the following if you attempt to do this when using an execution strategy.


InvalidOperationException: The configured execution strategy ‘SqlServerRetryingExecutionStrategy’ does not support user initiated transactions. Use the execution strategy returned by ‘DbContext.Database.CreateExecutionStrategy()’ to execute all the operations in the transaction as a retriable unit.


The solution is to manually invoke the execution strategy with a delegate representing everything that needs to be executed. If a transient failure occurs, the execution strategy will invoke the delegate again.

[!code-csharpMain]




Transaction commit failure and the idempotency issue

In general, when there is a connection failure the current transaction is rolled back. However, if the connection is dropped while the transaction is being committed the resulting state of the transaction is unknown. See this blog post [http://blogs.msdn.com/b/adonet/archive/2013/03/11/sql-database-connectivity-and-the-idempotency-issue.aspx] for more details.

By default, the execution strategy will retry the operation as if the transaction was rolled back, but if it’s not the case this will result in an exception if the new database state is incompatible or could lead to data corruption if the operation does not rely on a particular state, for example when inserting a new row with auto-generated key values.

There are several ways to deal with this.


Option 1 - Do (almost) nothing

The likelihood of a connection failure during transaction commit is low so it may be acceptable for your application to just fail if this condition actually occurs.

However, you need to avoid using store-generated keys in order to ensure that an exception is thrown instead of adding a duplicate row. Consider using a client-generated GUID value or a client-side value generator.




Option 2 - Rebuild application state


	Discard the current DbContext.

	Create a new DbContext and restore the state of your application from the database.

	Inform the user that the last operation might not have been completed successfully.






Option 3 - Add state verification

For most of the operations that change the database state it is possible to add code that checks whether it succeeded. EF provides an extension method to make this easier - IExecutionStrategy.ExecuteInTransaction.

This method begins and commits a transaction and also accepts a function in the verifySucceeded parameter that is invoked when a transient error occurs during the transaction commit.

[!code-csharpMain]


[!NOTE]
Here SaveChanges is invoked with acceptAllChangesOnSuccess set to false to avoid changing the state of the Blog entity to Unchanged if SaveChanges succeeds. This allows to retry the same operation if the commit fails and the transaction is rolled back.





Option 4 - Manually track the transaction

If you need to use store-generated keys or need a generic way of handling commit failures that doesn’t depend on the operation performed each transaction could be assigned an ID that is checked when the commit fails.


	Add a table to the database used to track the status of the transactions.

	Insert a row into the table at the beginning of each transaction.

	If the connection fails during the commit, check for the presence of the corresponding row in the database.

	If the commit is successful, delete the corresponding row to avoid the growth of the table.



[!code-csharpMain]


[!NOTE]
Make sure that the context used for the verification has an execution strategy defined as the connection is likely to fail again during verification if it failed during transaction commit.
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Testing

You may want to test components using something that approximates connecting to the real database, without the overhead of actual database I/O operations.

There are two main options for doing this:


	SQLite in-memory mode allows you to write efficient tests against a provider that behaves like a relational database.

	The InMemory provider is a lightweight provider that has minimal dependencies, but does not always behave like a relational database.
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Testing with SQLite

SQLite has an in-memory mode that allows you to use SQLite to write tests against a relational database, without the overhead of actual database operations.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Miscellaneous/Testing] on GitHub



Example testing scenario

Consider the following service that allows application code to perform some operations related to blogs. Internally it uses a DbContext that connects to a SQL Server database. It would be useful to swap this context to connect to an in-memory SQLite database so that we can write efficient tests for this service without having to modify the code, or do a lot of work to create a test double of the context.

[!code-csharpMain]




Get your context ready


Avoid configuring two database providers

In your tests you are going to externally configure the context to use the InMemory provider. If you are configuring a database provider by overriding OnConfiguring in your context, then you need to add some conditional code to ensure that you only configure the database provider if one has not already been configured.


[!TIP]If you are using ASP.NET Core, then you should not need this code since your database provider is configured outside of the context (in Startup.cs).


[!code-csharpMain]




Add a constructor for testing

The simplest way to enable testing against a different database is to modify your context to expose a constructor that accepts a DbContextOptions<TContext>.

[!code-csharpMain]


[!TIP]DbContextOptions<TContext> tells the context all of its settings, such as which database to connect to. This is the same object that is built by running the OnConfiguring method in your context.







Writing tests

The key to testing with this provider is the ability to tell the context to use SQLite, and control the scope of the in-memory database. The scope of the database is controlled by opening and closing the connection. The database is scoped to the duration that the connection is open. Typically you want a clean database for each test method.

[!code-csharpMain]
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Testing with InMemory

The InMemory provider is useful when you want to test components using something that approximates connecting to the real database, without the overhead of actual database operations.


[!TIP]You can view this article’s sample [https://github.com/aspnet/EntityFramework.Docs/tree/master/samples/core/Miscellaneous/Testing] on GitHub.



InMemory is not a relational database

EF Core database providers do not have to be relational databases. InMemory is designed to be a general purpose database for testing, and is not designed to mimic a relational database.

Some examples of this include:


	InMemory will allow you to save data that would violate referential integrity constraints in a relational database.

	If you use DefaultValueSql(string) for a property in your model, this is a relational database API and will have no effect when running against InMemory.




[!TIP]For many test purposes these differences will not matter. However, if you want to test against something that behaves more like a true relational database, then consider using SQLite in-memory mode.





Example testing scenario

Consider the following service that allows application code to perform some operations related to blogs. Internally it uses a DbContext that connects to a SQL Server database. It would be useful to swap this context to connect to an InMemory database so that we can write efficient tests for this service without having to modify the code, or do a lot of work to create a test double of the context.

[!code-csharpMain]




Get your context ready


Avoid configuring two database providers

In your tests you are going to externally configure the context to use the InMemory provider. If you are configuring a database provider by overriding OnConfiguring in your context, then you need to add some conditional code to ensure that you only configure the database provider if one has not already been configured.

[!code-csharpMain]


[!TIP]If you are using ASP.NET Core, then you should not need this code since your database provider is already configured outside of the context (in Startup.cs).





Add a constructor for testing

The simplest way to enable testing against a different database is to modify your context to expose a constructor that accepts a DbContextOptions<TContext>.

[!code-csharpMain]


[!TIP]DbContextOptions<TContext> tells the context all of its settings, such as which database to connect to. This is the same object that is built by running the OnConfiguring method in your context.







Writing tests

The key to testing with this provider is the ability to tell the context to use the InMemory provider, and control the scope of the in-memory database. Typically you want a clean database for each test method.

Here is an example of a test class that uses the InMemory database. Each test method specifies a unique database name, meaning each method has its own InMemory database.


[!TIP]
To use the .UseInMemoryDatabase() extension method, reference the Nuget package Microsoft.EntityFrameworkCore.InMemory.


[!code-csharpMain]
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Design-time DbContext Creation

Some of the EF Tools commands require a DbContext instance to be created at design time (for example, when running
Migrations commands). There are various ways the tools will try and do this.


From application services

If your startup project is an ASP.NET Core app, the tools will try to obtain the DbContext object from the application’s
service provider. This is done by invoking Program.BuildWebHost() and accessing the IWebHost.Services property. Any
DbContext registered using IServiceCollection.AddDbContext<TContext>() can be found and created this way. This pattern
was introduced in ASP.NET Core 2.0 [https://docs.microsoft.com/aspnet/core/migration/1x-to-2x/#update-main-method-in-programcs]




Using the default constructor

If the DbContext can’t be obtained from the application service provider, the tools will find the DbContext type inside
the project and try to create it using its default constructor.




From a design-time factory

You can also tell the tools how to create your DbContext by implementing IDesignTimeDbContextFactory. If a class
implementing this interface is found inside your project, the tools will bypass the other ways of creating the DbContext
and always use the factory at design time. This is especially useful if you need to configure the DbContext differently
for design time than at runtime.

using Microsoft.EntityFrameworkCore;
using Microsoft.EntityFrameworkCore.Infrastructure;

namespace MyProject
{
    public class BloggingContextFactory : IDesignTimeDbContextFactory<BloggingContext>
    {
        public BloggingContext CreateDbContext(string[] args)
        {
            var optionsBuilder = new DbContextOptionsBuilder<BloggingContext>();
            optionsBuilder.UseSqlite("Data Source=blog.db");

            return new BloggingContext(optionsBuilder.Options);
        }
    }
}






[!NOTE]
The args parameter is currently unused. There is an issue [https://github.com/aspnet/EntityFrameworkCore/issues/8332] tracking the ability to specify design-time arguments
from the tools.
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Entity Framework Core Tools

The Entity Framework Core Tools help you during the development of EF Core apps. They’re primarily used to scaffold a
DbContext and entity types by reverse engineering the schema of a database, and to manage Migrations.

The EF Core Package Manager Console (PMC) Tools provide a superior experience inside Visual Studio. Run them using
NuGet’s Package Manager Console [https://docs.microsoft.com/nuget/tools/package-manager-console]. These tools work with both .NET Framework and .NET Core projects.

The EF Core .NET Command Line Tools are an extension to the .NET Core command-line interface (CLI) tools [https://docs.microsoft.com/dotnet/core/tools/] that
are cross-platform and can run outside of Visual Studio. These tools require a .NET Core SDK project (one with
Sdk="Microsoft.NET.Sdk" or similar in the project file).

Both tools expose the same functionality. If you’re developing in Visual Studio, we recommend using the PMC Tools since
they provide a more integrated experience.


Frameworks

The tools support projects targeting .NET Framework or .NET Core.

If your project targets another framework (e.g. Universal Windows or Xamarin), we recommend creating a separate .NET
Standard project and cross-targeting one of the supported frameworks.

To cross-target .NET Core, for example, right-click on the project and select Edit *.csproj. Update the
TargetFramework property as follows. (Note, the property name becomes plural.)

<TargetFrameworks>netcoreapp2.0;netstandard2.0</TargetFrameworks>





If you’re using a .NET Standard class library, you don’t need to cross-target if your startup project targets .NET
Framework or .NET Core.




Startup and Target Projects

Whenever you invoke a command, there are two projects involved: the target project and the startup project.

The target project is where any files are added (or in some cases removed).

The startup project is the one emulated by the tools when executing your project’s code.

Both the target project and the startup project can be the same.







          

      

      

    

  

  
    
    
    EF Core Package Manager Console Tools
    
    

    
 
  
  

    
      
          
            
  

title: Package Manager Console (Visual Studio) - EF Core
author: bricelam
ms.author: bricelam
ms.date: 11/6/2017
ms.technology: entity-framework-core




EF Core Package Manager Console Tools

The EF Core Package Manager Console (PMC) Tools run inside of Visual Studio using NuGet’s Package Manager Console [https://docs.microsoft.com/nuget/tools/package-manager-console].
These tools work with both .NET Framework and .NET Core projects.


[!TIP]
Not using Visual Studio? The EF Core command Line Tools are cross-platform and run inside a command prompt.



Installing the tools

Install the EF Core Package Manager Console Tools by installing the Microsoft.EntityFrameworkCore.Tools NuGet package.
You can do this by executing the following command inside Package Manager Console [https://docs.microsoft.com/nuget/tools/package-manager-console].

Install-Package Microsoft.EntityFrameworkCore.Tools





If everything worked correctly, you should be able to run this command:

Get-Help about_EntityFrameworkCore






[!TIP]
If your startup project targets .NET Standad, cross-target a supported framework before using the tools.



[!IMPORTANT]
If you’re using Universal Windows or Xamarin, move your EF code to a .NET Standard class library and
cross-target a supported framework before using the tools. Specify the class library as your startup project.





Using the tools

Whenever you invoke a command, there are two projects involved:

The target project is where any files are added (or in some cases removed). The target project defaults to the
Default project selected in Pacage Manager Console, but can also be specified using the -Project parameter.

The startup project is the one emulated by the tools when executing your project’s code. It defaults to one
Set as StartUp Project in Solution Explorer, but can also be specified using the -StartupProject parameter.

Common parameters:

|                           |                             |
| ————————- | ————————— |
| -Context <String>        | The DbContext to use.       |
| -Project <String>        | The project to use.         |
| -StartupProject <String> | The startup project to use. |
| -Verbose                  | Show verbose output.        |

To show help information about a command, use PowerShell’s Get-Help command.


[!TIP]
The Context, Project, and StartupProject parameters support tab-expansion.



[!TIP]
Set env:ASPNETCORE_ENVIRONMENT before running to specify the ASP.NET Core environment.





Commands


Add-Migration

Adds a new migration.

Parameters:

|                                    |                                                                                 |
| ———————————- | ——————————————————————————- |
| -Name <String>              | The name of the migration.                                                      |
| -OutputDir <String>  | The directory (and sub-namespace) to use. Paths are relative to the project directory. Defaults to “Migrations”. |


[!NOTE]
Parameters in bold are required, and ones in italics are positional.





Drop-Database

Drops the database.

Parameters:

|          |                                                          |
| ——– | ——————————————————– |
| -WhatIf  | Show which database would be dropped, but don’t drop it. |




Get-DbContext

Gets information about a DbContext type.




Remove-Migration

Removes the last migration.

Parameters:

|        |                                                                       |
| —— | ——————————————————————— |
| -Force | Don’t check to see if the migration has been applied to the database. |




Scaffold-DbContext

Scaffolds a DbContext and entity types for a database.

Parameters:

|                                          |                                                                           |
| —————————————- | ————————————————————————- |
| -Connection <String> | The connection string to the database.                                    |
| -Provider <String>                | The provider to use. (E.g. Microsoft.EntityFrameworkCore.SqlServer)       |
| -OutputDir <String>                     | The directory to put files in. Paths are relaive to the project directory. |
| -Context <String>                       | The name of the DbContext to generate.                                    |
| -Schemas <String[]>                     | The schemas of tables to generate entity types for.                       |
| -Tables <String[]>                      | The tables to generate entity types for.                                  |
| -DataAnnotations                         | Use attributes to configure the model (where possible). If omitted, only the fluent API is used. |
| -UseDatabaseNames                        | Use table and column names directly from the database.                    |
| -Force                                   | Overwrite existing files.                                                 |




Script-Migration

Generates a SQL script from migrations.

Parameters:

|                   |                                                                    |
| —————– | —————————————————————— |
| -From <String> | The starting migration. Defaults to 0 (the initial database).      |
| -To <String>   | The ending migration. Defaults to the last migration.              |
| -Idempotent       | Generate a script that can be used on a database at any migration. |
| -Output <String> | The file to write the result to.                                   |


[!TIP]
The To, From, and Output parameters support tab-expansion.





Update-Database

|                                     |                                                                                |
| ———————————– | —————————————————————————— |
| -Migration <String> | The target migration. If ‘0’, all migrations will be reverted. Defaults to the last migration. |


[!TIP]
The Migration parameter supports tab-expansion.
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Design-time services

Some services used by the tools are only used at design time. These services are managed seperately from EF Core’s
runtime services to prevent them from being deployed with your app. To override one of these services (for example the
service to generate migration files) add an implementation of IDesignTimeServices to your startup project.

class MyDesignTimeServices : IDesignTimeServices
{
    public void ConfigureDesignTimeServices(IServiceCollection services)
        => services.AddSingleton<IMigrationsCodeGenerator, MyMigrationsCodeGenerator>()
}
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EF Core .NET Command Line Tools

The Entity Framework Core .NET Command Line Tools are an extension to the cross-platform dotnet command which is
part of the .NET Core SDK [https://www.microsoft.com/net/core].


[!TIP]
If you’re using Visual Studio, we recommend the the PMC Tools instead since they provide a more integrated
experience.



Installing the tools

Install the EF Core .NET Command Line Tools using these steps:


	Edit the project file and add Microsoft.EntityFrameworkCore.Tools.DotNet as a DotNetCliToolReference item (See below)



	Run the following in a command prompt:

dotnet add package Microsoft.EntityFrameworkCore.Design
dotnet restore









The resulting project should look something like this:

<Project Sdk="Microsoft.NET.Sdk">
  <PropertyGroup>
    <OutputType>Exe</OutputType>
    <TargetFramework>netcoreapp2.0</TargetFramework>
  </PropertyGroup>
  <ItemGroup>
    <PackageReference Include="Microsoft.EntityFrameworkCore.Design"
                      Version="2.0.0"
                      PrivateAssets="All" />
  </ItemGroup>
  <ItemGroup>
    <DotNetCliToolReference Include="Microsoft.EntityFrameworkCore.Tools.DotNet"
                            Version="2.0.0" />
  </ItemGroup>
</Project>






[!NOTE]
A package reference with PrivateAssets="All" means it won’t be exposed to projects that reference this project. This
is especially useful for packages that are typically only used during development.


If you did everything right, you should be able to successfully run the following command in a command prompt.

dotnet ef








Using the tools

Whenever you invoke a command, there are two projects involved:

The target project is where any files are added (or in some cases removed). The target project defaults to the project
in the current directory, but can be changed using the –project option.

The startup project is the one emulated by the tools when executing your project’s code. It also defaults to the project
in the current directory, but can be changed using the –startup-project option.

Common options:

|    |                                  |                             |
| – | ——————————– | ————————— |
|    | –json                           | Show JSON output.           |
| -c | –context <DBCONTEXT>           | The DbContext to use.       |
| -p | –project <PROJECT>             | The project to use.         |
| -s | –startup-project <PROJECT>     | The startup project to use. |
|    | –framework <FRAMEWORK>         | The target framework.       |
|    | –configuration <CONFIGURATION> | The configuration to use.   |
|    | –runtime <IDENTIFIER>          | The runtime to use.         |
| -h | –help                           | Show help information.      |
| -v | –verbose                        | Show verbose output.        |
|    | –no-color                       | Don’t colorize output.      |
|    | –prefix-output                  | Prefix output with level.   |


[!TIP]
To specify the ASP.NET Core environment, set the ASPNETCORE_ENVIRONMENT environment variable before running.





Commands


dotnet ef database drop

Drops the database.

Options:

|    |           |                                                          |
| – | ——— | ——————————————————– |
| -f | –force   | Don’t confirm.                                           |
|    | –dry-run | Show which database would be dropped, but don’t drop it. |




dotnet ef database update

Updates the database to a specified migration.

Arguments:

|              |                                                                                              |
| ———— | ———————————————————————————————|
| <MIGRATION> | The target migration. If 0, all migrations will be reverted. Defaults to the last migration. |




dotnet ef dbcontext info

Gets information about a DbContext type.




dotnet ef dbcontext list

Lists available DbContext types.




dotnet ef dbcontext scaffold

Scaffolds a DbContext and entity types for a database.

Arguments:

|               |                                                                     |
| ————- | ——————————————————————- |
| <CONNECTION> | The connection string to the database.                              |
| <PROVIDER>   | The provider to use. (E.g. Microsoft.EntityFrameworkCore.SqlServer) |

Options:

|                 |                                         |                                                          |
| ————— | ————————————— | ——————————————————– |
| -d |       –data-annotations                | Use attributes to configure the model (where possible). If omitted, only the fluent API is used. |
|       -c        |       –context <NAME>                 | The name of the DbContext.                               |
|       -f        |       –force                           | Overwrite existing files.                                |
|       -o        |       –output-dir <PATH>              | The directory to put files in. Paths are relative to the project directory. |
|                 | –schema <SCHEMA_NAME>... | The schemas of tables to generate entity types for.      |
|       -t        |       –table <TABLE_NAME>...          | The tables to generate entity types for.                 |
|                 |       –use-database-names              | Use table and column names directly from the database.   |




dotnet ef migrations add

Adds a new migration.

Arguments:

|         |                            |
| ——- | ————————– |
| <NAME> | The name of the migration. |

Options:

|                 |                                   |                                                                |
| ————— |———————————- | ————————————————————– |
| -o | –output-dir <PATH> | The directory (and sub-namespace) to use. Paths are relative to the project directory. Defaults to “Migrations”. |




dotnet ef migrations list

Lists available migrations.




dotnet ef migrations remove

Removes the last migration.

Options:

|    |         |                                                                       |
| – | ——- | ——————————————————————— |
| -f | –force | Don’t check to see if the migration has been applied to the database. |




dotnet ef migrations script

Generates a SQL script from migrations.

Arguments:

|         |                                                               |
| ——- | ————————————————————- |
| <FROM> | The starting migration. Defaults to 0 (the initial database). |
| <TO>   | The ending migration. Defaults to the last migration.         |

Options:

|    |                  |                                                                    |
| – | —————- | —————————————————————— |
| -o | –output <FILE> | The file to write the result to.                                   |
| -i | –idempotent     | Generate a script that can be used on a database at any migration. |
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Managing Database Schemas

EF Core provides two primary ways of keeping your EF Core model and database schema in sync. To choose between the two,
you need to decide whether your EF Core model or the database schema is the source of truth.

If you want your EF Core model to be the source of truth, use Migrations. As you make changes to your EF Core
model, this approach will incrementally apply the corresponding schema changes to your database so that it remains
compatible with your EF Core model.

Use Reverse Engineering if you want your database schema to be the source of truth. This approach allows you to
scaffold a DbContext and the entity type classes by reverse engineering your database schema into an EF Core model.
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🔧 Reverse Engineering


[!NOTE]
This topic hasn’t been written yet! You can track the status of this issue [https://github.com/aspnet/EntityFramework.Docs/issues/508] through our public GitHub issue
tracker. Learn how you can contribute [https://github.com/aspnet/EntityFramework.Docs/blob/master/CONTRIBUTING.md] on GitHub.
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🔧 Migrations


[!NOTE]
This topic hasn’t been written yet! You can track the status of this issue [https://github.com/aspnet/EntityFramework.Docs/issues/507] through our public GitHub issue
tracker. Learn how you can contribute [https://github.com/aspnet/EntityFramework.Docs/blob/master/CONTRIBUTING.md] on GitHub.
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Maximum Length

Configuring a maximum length provides a hint to the data store about the appropriate data type to use for a given property. Maximum length only applies to array data types, such as string and byte[].


[!NOTE]Entity Framework does not do any validation of maximum length before passing data to the provider. It is up to the provider or data store to validate if appropriate. For example, when targeting SQL Server, exceeding the maximum length will result in an exception as the data type of the underlying column will not allow excess data to be stored.



Conventions

By convention, it is left up to the database provider to choose an appropriate data type for properties. For properties that have a length, the database provider will generally choose a data type that allows for the longest length of data. For example, Microsoft SQL Server will use nvarchar(max) for string properties (or nvarchar(450) if the column is used as a key).




Data Annotations

You can use the Data Annotations to configure a maximum length for a property. In this example, targeting SQL Server this would result in the nvarchar(500) data type being used.


``` csharp
public class Blog
{
    public int BlogId { get; set; }
    [MaxLength(500)]
    public string Url { get; set; }
}
```


Fluent API

You can use the Fluent API to configure a maximum length for a property. In this example, targeting SQL Server this would result in the nvarchar(500) data type being used.


``` csharp
class MyContext : DbContext
{
    public DbSet Blogs { get; set; }protected override void OnModelCreating(ModelBuilder modelBuilder)
{
    modelBuilder.Entity<Blog>()
        .Property(b => b.Url)
        .HasMaxLength(500);
}





}

public class Blog
{
public int BlogId { get; set; }
public string Url { get; set; }
}
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Creating a Model

Entity Framework uses a set of conventions to build a model based on the shape of your entity classes. You can specify additional configuration to supplement and/or override what was discovered by convention.

This article covers configuration that can be applied to a model targeting any data store and that which can be applied when targeting any relational database. Providers may also enable configuration that is specific to a particular data store. For documentation on provider specific configuration see the
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Including & Excluding Types

Including a type in the model means that EF has metadata about that type and will attempt to read and write instances from/to the database.


Conventions

By convention, types that are exposed in DbSet properties on your context are included in your model. In addition, types that are mentioned in the OnModelCreating method are also included. Finally, any types that are found by recursively exploring the navigation properties of discovered types are also included in the model.

For example, in the following code listing all three types are discovered:


	Blog because it is exposed in a DbSet property on the context

	Post because it is discovered via the Blog.Posts navigation property

	AuditEntry because it is mentioned in OnModelCreating




``` csharp
class MyContext : DbContext
{
    public DbSet Blogs { get; set; }protected override void OnModelCreating(ModelBuilder modelBuilder)
{
    modelBuilder.Entity<AuditEntry>();
}





}

public class Blog
{
public int BlogId { get; set; }
public string Url { get; set; }

public List<Post> Posts { get; set; }





}

public class Post
{
public int PostId { get; set; }
public string Title { get; set; }
public string Content { get; set; }

public Blog Blog { get; set; }





}

public class AuditEntry
{
public int AuditEntryId { get; set; }
public string Username { get; set; }
public string Action { get; set; }
}


## Data Annotations

You can use Data Annotations to exclude a type from the model.

<!-- [!code-csharp[Main](samples/core/Modeling/DataAnnotations/Samples/IgnoreType.cs?highlight=9)] -->
``` csharp
public class Blog
{
    public int BlogId { get; set; }
    public string Url { get; set; }

    public BlogMetadata Metadata { get; set; }
}

[NotMapped]
public class BlogMetadata
{
    public DateTime LoadedFromDatabase { get; set; }
}
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Alternating between multiple models with the same DbContext type

The model built in OnModelCreating could use a property on the context to change how the model is built. For example it could be used to exclude a certain property:

[!code-csharpMain]


IModelCacheKeyFactory

However if you tried doing the above without additional changes you would get the same model every time a new context is created for any value of IgnoreIntProperty. This is caused by the model caching mechanism EF uses to improve the performance by only invoking OnModelCreating once and caching the model.

By default EF assumes that for any given context type the model will be the same. To accomplish this the default implementation of IModelCacheKeyFactory returns a key that just contains the context type. To change this you need to replace the IModelCacheKeyFactory service. The new implementation needs to return an object that can be compared to other model keys using the Equals method that takes into account all the variables that affect the model:

[!code-csharpMain]
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Relationships

A relationship defines how two entities relate to each other. In a relational database, this is represented by a foreign key constraint.


[!NOTE]Most of the samples in this article use a one-to-many relationship to demonstrate concepts. For examples of one-to-one and many-to-many relationships see the Other Relationship Patterns section at the end of the article.



Definition of Terms

There are a number of terms used to describe relationships


	Dependent entity: This is the entity that contains the foreign key property(s). Sometimes referred to as the ‘child’ of the relationship.

	Principal entity: This is the entity that contains the primary/alternate key property(s). Sometimes referred to as the ‘parent’ of the relationship.

	Foreign key: The property(s) in the dependent entity that is used to store the values of the principal key property that the entity is related to.

	Principal key: The property(s) that uniquely identifies the principal entity. This may be the primary key or an alternate key.

	Navigation property: A property defined on the principal and/or dependent entity that contains a reference(s) to the related entity(s).
	Collection navigation property: A navigation property that contains references to many related entities.

	Reference navigation property: A navigation property that holds a reference to a single related entity.

	Inverse navigation property: When discussing a particular navigation property, this term refers to the navigation property on the other end of the relationship.







The following code listing shows a one-to-many relationship between Blog and Post


	Post is the dependent entity

	Blog is the principal entity

	Post.BlogId is the foreign key

	Blog.BlogId is the principal key (in this case it is a primary key rather than an alternate key)

	Post.Blog is a reference navigation property

	Blog.Posts is a collection navigation property

	Post.Blog is the inverse navigation property of Blog.Posts (and vice versa)



[!code-csharpMain]




Conventions

By convention, a relationship will be created when there is a navigation property discovered on a type. A property is considered a navigation property if the type it points to can not be mapped as a scalar type by the current database provider.


[!NOTE]Relationships that are discovered by convention will always target the primary key of the principal entity. To target an alternate key, additional configuration must be performed using the Fluent API.



Fully Defined Relationships

The most common pattern for relationships is to have navigation properties defined on both ends of the relationship and a foreign key property defined in the dependent entity class.


	If a pair of navigation properties is found between two types, then they will be configured as inverse navigation properties of the same relationship.

	If the dependent entity contains a property named <primary key property name>, <navigation property name><primary key property name>, or <principal entity name><primary key property name> then it will be configured as the foreign key.



[!code-csharpMain]


[!WARNING]If there are multiple navigation properties defined between two types (i.e. more than one distinct pair of navigations that point to each other), then no relationships will be created by convention and you will need to manually configure them to identify how the navigation properties pair up.





No Foreign Key Property

While it is recommended to have a foreign key property defined in the dependent entity class, it is not required. If no foreign key property is found, a shadow foreign key property will be introduced with the name <navigation property name><principal key property name> (see Shadow Properties for more information).

[!code-csharpMain]




Single Navigation Property

Including just one navigation property (no inverse navigation, and no foreign key property) is enough to have a relationship defined by convention. You can also have a single navigation property and a foreign key property.

[!code-csharpMain]




Cascade Delete

By convention, cascade delete will be set to Cascade for required relationships and ClientSetNull for optional relationships. Cascade means dependent entities are also deleted. ClientSetNull means that dependent entities that are not loaded into memory will remain unchanged and must be manually deleted, or updated to point to a valid principal entity. For entities that are loaded into memory, EF Core will attempt to set the foreign key properties to null.

See the Required and Optional Relationships section for the difference between required and optional relationships.

See Cascade Delete for more details about the different delete behaviors and the defaults used by convention.






Data Annotations

There are two data annotations that can be used to configure relationships, [ForeignKey] and [InverseProperty].


[ForeignKey]

You can use the Data Annotations to configure which property should be used as the foreign key property for a given relationship. This is typically done when the foreign key property is not discovered by convention.

[!code-csharpMain]


[!TIP]The [ForeignKey] annotation can be placed on either navigation property in the relationship. It does not need to go on the navigation property in the dependent entity class.





[InverseProperty]

You can use the Data Annotations to configure how navigation properties on the dependent and principal entities pair up. This is typically done when there is more than one pair of navigation properties between two entity types.

[!code-csharpMain]






Fluent API

To configure a relationship in the Fluent API, you start by identifying the navigation properties that make up the relationship. HasOne or HasMany identifies the navigation property on the entity type you are beginning the configuration on. You then chain a call to WithOne or WithMany to identify the inverse navigation. HasOne/WithOne are used for reference navigation properties and HasMany/WithMany are used for collection navigation properties.

[!code-csharpMain]


Single Navigation Property

If you only have one navigation property then there are parameterless overloads of WithOne and WithMany. This indicates that there is conceptually a reference or collection on the other end of the relationship, but there is no navigation property included in the entity class.

[!code-csharpMain]




Foreign Key

You can use the Fluent API to configure which property should be used as the foreign key property for a given relationship.

[!code-csharpMain]

The following code listing shows how to configure a composite foreign key.

[!code-csharpMain]

You can use the string overload of HasForeignKey(...) to configure a shadow property as a foreign key (see Shadow Properties for more information). We recommend explicitly adding the shadow property to the model before using it as a foreign key (as shown below).

[!code-csharpMain]




Principal Key

If you want the foreign key to reference a property other than the primary key, you can use the Fluent API to configure the principal key property for the relationship. The property that you configure as the principal key will automatically be setup as an alternate key (see Alternate Keys for more information).


``` csharp
class MyContext : DbContext
{
    public DbSet Cars { get; set; }protected override void OnModelCreating(ModelBuilder modelBuilder)
{
    modelBuilder.Entity<RecordOfSale>()
        .HasOne(s => s.Car)
        .WithMany(c => c.SaleHistory)
        .HasForeignKey(s => s.CarLicensePlate)
        .HasPrincipalKey(c => c.LicensePlate);
}





}

public class Car
{
public int CarId { get; set; }
public string LicensePlate { get; set; }
public string Make { get; set; }
public string Model { get; set; }

public List<RecordOfSale> SaleHistory { get; set; }





}

public class RecordOfSale
{
public int RecordOfSaleId { get; set; }
public DateTime DateSold { get; set; }
public decimal Price { get; set; }

public string CarLicensePlate { get; set; }
public Car Car { get; set; }





}


The following code listing shows how to configure a composite principal key.

<!-- [!code-csharp[Main](samples/core/Modeling/FluentAPI/Samples/Relationships/CompositePrincipalKey.cs?highlight=11)] -->
``` csharp
class MyContext : DbContext
{
    public DbSet<Car> Cars { get; set; }

    protected override void OnModelCreating(ModelBuilder modelBuilder)
    {
        modelBuilder.Entit